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1 Product description 

1.1 Introduction  

 

SKF Microlog Analyzer dBX is a portable condition monitoring system that uses 

hybrid, keypad and touchscreen navigation based on a Microsoft Windows operating 

system. 

 

The dBX Series Microlog system is used by machinery maintenance personnel who 

wish to collect and analyze vibration data from their rotating machinery, to help 

reduce maintenance costs and downtime. 

 

A dBX Series Microlog System consists of three components:  

 

• Microlog dBX Vibration Analyser 

 

• Application modules installed on the Microlog Vibration Analyser 

 

• A host computer with SKF @ptitude Analyst software and the Thin Client 

Transfer TCT.dBX or SKF @ptitude Observer software and the Data Bridge 

web service. 

 

Note: If the SKF @ptitude Analyst software is hosted on the cloud, only 

TCT.dBX is required on the host computer, along with the end point 

connection information to access the @ptitude Analyst Transaction Service. 

 

The Microlog Analyzer dBX data collector is a portable, four channel data acquisition 

and storage terminal. It collects machinery vibration, temperature, and other 

condition monitoring measurements. Together with visual observations, Microlog 

Analyzer dBX allows for detailed machine condition analyses in a harsh industrial 

environment. 

 

The Microlog Analyzer dBX, with its preinstalled and licensed modules, performs 

tasks required for machinery predictive maintenance.  

 If the equipment is used in a manner not specified by the manufacturer, 

both the safety and functionality of the equipment may be impaired. 

 Before using the software, please read and understand the separate 

Microlog Analyzer dBX Quick Start Guide. 
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It automatically collects both dynamic (vibration) and static (process) measurements 

from almost any source, it provides easy to use setup screens for quickly capturing 

data related to specific applications, such as balancing, etc., and it allows you to 

configure one or twelve measurements for automatic data collection at one sensor 

location. 

1.2 Third party licences 
 

Some pieces of licensed software such as open source or third-party libraries have 

been used when developing this product. 

For any enquiries contact SKF’s Technical Support Group TSG. 

1.3 Startup password 
 

Adding a startup password to your Microlog Analyzer dBX helps protect your data 

and secure your device. You can select to change, enable, or disable the password 

option from the Utility module.  

1.3.1 Setting up a startup password 

 

When the Microlog Analyzer dBX is powered on for the first time, the system requires 

you to set up a startup password.  

 

 

Figure 1 Login screen – Set password 

  

http://www.skf.com/cm/tsg
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1. Tap the Set password field to display the keypad and enter the password.  

  

2. Re-enter the password in the Verification field. 

 

 

Figure 2 Password keypad  

Once the password configuration is complete, the system will require you to enter the 

password each time the device is powered on. 

Tap the Password field to display the keypad and enter the password to log in. 

 

Figure 3 Log in with password 
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1.3.2 Skip the password option 

 

To skip the password option and log in directly, tap Skip at the bottom-right corner of 

the display. 

Note: If you select Skip, the password option will be disabled. To enable the 

password option, go to the Utility module. 

1.3.3 Reset a forgotten password  

 

1. Contact SKF’s Technical Support Group TSG and provide the serial number 

(SN) located at the top left corner of the display to get an unlock code.  

 

2. Use the unlock code to log in to the system again.  

 

3. After an unlock code is used, reset the password settings from the Utility 

module. 

 

 

Figure 4 Serial number – example 

 

1.3.4 Logout  

 

To log out, click the logout  icon in the top right corner of the home screen. 

 

In the Utility module, you can set a timer for auto logout.  

 

Note that setting a startup password is required to use the logout function. 
  

http://www.skf.com/cm/tsg
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1.4  USB Security 
 

To protect the device from cyber-attacks via its USB connector, Microlog dBX 

implements USB port locking. 

 

In normal circumstances, the USB port is blocked from operating with any of the 

following approved devices: 

 

• USB mouse 

• Approved USB transfer cable (CMAC 9010) 

• Power-only devices such as USB torches 

• Approved USB-HDMI output adaptors 

 

Note: The only other type of USB device allowed is a flash drive/memory stick type.  

Since this type of device can be used to deliver malware to a Windows-based 

computer system, the dBX implements a trust process which is triggered if the user 

attaches a USB memory key to the device, but only while the following applications 

are active: 

• Analyzer (or any of its derivatives such as gE Enveloping) 

• Balancing 

• Utility 

• dBX Documents  

 

Upon inserting a USB memory key in the above circumstances, the device will 

display a prompt message: < file “Trust USB” to be sent > 

Tap Yes to enable the key and continue or No to cancel. In the latter case, the USB 

device will not be available. 

 

  

As a further security step, if a start-up password is set in the device, see Startup 

password, the user will be prompted to enter the password before the key becomes 

available to the application. 
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1.5 Battery 
 

Microlog Analyzer dBX uses two batteries in sequence. The power manager uses the 

first battery and then switches to the second battery when first battery is drained. 

 

Note: To balance usage time and maintain the health of both batteries, swap them 

every six months. 

 

When both batteries are used, the percentage level is calculated by setting their 

combined full power as 100%. 

  

The battery symbol in the top right corner shows the remaining battery level or 

indicates if the device is connected to a charger. The battery symbol colour changes 

based on the battery level. 

 

Symbol Description 

 
Battery level above 20%. 

 
Battery level is between 10% and 20%. 

 
Battery level is below 10%. 

 

Connected to a charger. 

Note: The charging symbol may take up to 20 

seconds to appear after connecting the charger. 
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2 Data Collector module 

2.1 Introduction 
 

 

The Data Collector module is used for collecting data with the Routes built from the 

SKF @ptitude Analyst or SKF @ptitude Observer software and downloaded to the 

Microlog Analyzer dBX.  

 

Enter a Route from the Data Collector module, select a Point node and perform 

measurements for each Point. Upload the archive data to the SKF @ptitude Analyst 

or SKF @ptitude Observer for further analysis and creating reports. 

 

To start Data Collector, using the navigation keys, navigate to the SKF Data Collector 

icon and press OK or double tap the icon. 

 

 

Figure 5 Home screen – Data Collector icon 

  

 Before using the software, please read and understand the separate 

Microlog Analyzer dBX Quick Start Guide document. 
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2.2 Route manager  

2.2.1 Introduction 

 

When you open Data Collector, you will see the Route manager view. The Route 

manager presents the available Routes stored on the device. Use the navigation 

keys or double tap on a Route to select it. 

 

The Route information or instruction will be displayed on the right side of the display. 

Select Route Instruction or Information view by tapping one of the tags on the top. 

 

Note: The Instruction information will be available if the downloaded Route contains 

instructions. 

 

➢ A Route is a predefined sequence of measurements representing the Point of 

measurement on one or multiple pieces of equipment within a device or 

machines of a factory.  

 

 

Figure  6 Route Instruction view 

1. Menu buttons  

 

 1
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Figure 7 Route Information view 

2.2.2 Open Route  

 

To open a Route, use the navigation keys to select a Route and press the OK key or 

tap Open route. 

 

If there is no username downloaded, it will open the Route directly.  

 

For the username to be available, download it together with the Route. Every 

user/operator set is part of each individual Route.  

 

If you log in with a username, it will be saved to the Route, giving the possibility to 

track which user performs the data collection. 

 

Tap Back to return to the previous view. 

2.2.3 Configuration  

  

From the configuration view, you can set up the optional functions. Select from four 

sub-menus for setting up the related parameters Axis, Display, Measurements, and 

Log option. 
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Figure 8 Configuration view 

• Axis 

 

o X-Axis in Spectrum – Select Hz, CPM or Order. The selected unit 

will be displayed as the default X-Axis unit for Spectrum plots. 

 

o Y-Axis – Select Linear or Log scale as the Y-axis of Spectrum plots. 

 

o Y-axis peak threshold – Select a percentage number as the default 

Y-axis peak threshold used to select peaks when the cursor’s jump 

peak function is enabled. Those peaks whose amplitudes are higher 

than the threshold level will be selected for the cursor to move on 

them.  

You can change the threshold level manually when working with a 

cursor. 
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• Display 

 

o Plot mode – Select Overlap or Separate as the default plot format. 

This option will set the default format of multiple channels as overlap 

or separate. You can change the setting from the display menu of a 

plot. 

 

 

  

Figure 9 Overlap display (left), Separate display (right) 

o Show 1X – Select On or Off from the dropdown. Shows the running 

speed as a vertical dotted line in the FFT plot. 
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o Show band alarm - Select On or Off from the dropdown menu.  

On – Will show you the band alarm curves when the Route contains 

band alarm information. 

Off – Will hide the band alarm curves as default.  

You can change the setting from the display menu of a spectral plot. 

 

 

 

Figure 10 Band alarm   

o Show Fault frequencies – Select On or Off from the dropdown 

menu. 

On – Will show you the fault frequencies on a spectral plot when the 

Route contains fault frequencies information. 

Off – Will hide the fault frequencies as default. You can change the 

setting from the display menu of a spectral plot. 
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Figure 11 Fault frequency   

 

Figure 12 Highlighted peaks – example   

o Orbit filter – Set the default Orbit filter from the menu for orbit plots. 

You can also change the setting from the plot menu of an orbit plot. 
 

  

 

o Orbit cycle – Select the between 1–16 orbit cycles for the orbit plots. 

You can also change the setting from the plot menu of an orbit plot. 
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o Jump peak – Select default value On or Off from the dropdown 

menu. Peaks are sorted by y-value and the top 10 peaks are 

highlighted. With the Jump Peak function is enabled, the cursor will 

jump from one peak to another when you move it. You can turn the 

Jump Peak function on or off by pressing the Up key twice while 

working with a plot. 

 

• Measurements 

 

o Auto advance – Select On or Off from the dropdown menu. 

On – Move the selected Point to the next Point automatically when 

the measurement of a Point is completed. 

Off – Move the cursor manually to the next Point.  

 
 

o Measurement Mode – Select Auto or Manual from the 

measurement mode menu. When Auto is selected, the measurement 

will start directly after the Start / Stop key is pressed.  

When Manual is selected, it will only show the waveforms charts after 

the Start / Stop key is pressed, but it will not start the measurement 

until the OK key is pressed for confirmation. 
 

 
 

o Historical data – Select Always append or Always overwrite from 

the Historical data menu. 

When Always Append is selected, new measurement data is added 

to the historical data table, which stores up to 12 most recent records. 

If the table reaches its 12-record limit, the oldest record will be 

automatically deleted when a new data is stored.  

When Always overwrite is selected, the last measurement data will 

be overwritten by the new measurement data and only one data 

record is stored in the historical data table. 
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o Auto Save (Sec) – Select Off, 1, 2, 3, 4, or 5 seconds from the 

menu. When Off is selected, you must tap Save after each 

measurement. If you select a number of seconds, the measured data 

is saved automatically after the specified time. 

 

 
 

Tap Load default to restore the settings to default values. 

 

• Log option 

 

o Auto log raw data – At the beginning of each measurement, the data 

collector module acquires the raw data, which is a continuous signal 

record sampled at 102.4 kHz.  

The raw data can be converted into various measured functions to 

complete the measurement. You can replay the raw data file as an 

audio clip using a Bluetooth headset or perform post analysis to 

derive more information for diagnosis purposes. 

 

Note: The raw data will occupy a large storage space, and its use 

should be avoided.   

 

Select Off, On, Alert or Danger from the dropdown menu as the default raw data 

logging status after each measurement. 

 

o Off – Never store the raw data. 

o On – Always store the raw data. 

o Alert – Store the raw data when the measured data is in alert status 

(Alarm 1). 

o Danger: Store the raw data when the measured data is in Danger 

status (Alarm 2). 
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2.2.4 Tools 

 

From the Tools menu, you can delete a selected Route, clear the archive data of a 

selected Route, check the ICP bias and power, or enable the Sensor Manager to edit 

the sensors used with your data collector. 

 

 

• ICP bias check – opens a new window, where you can connect your ICP 

sensors for testing.   

Select Verify to perform the checking, the result is shown in a window, which 

may indicate one of the following conditions: 

 

o Short circuit (low bias) – Usually indicates a faulty cable with a 

short loop. 

o Normal (normal bias) – The ICP circuit is working normally. 

o Open circuit (high bias) – If there is no sensor connecting to this 

channel, the bias check shows status Open. If an ICP sensor is 

connected to this channel, open circuit usually means a faulty cable.  

 

 

 

• ICP power check – Select ICP Power® to check the ICP power supply of 

your Microlog dBX. To perform the checking, disconnect all sensors and 

select Verify. In normal conditions, the power supply of all channels should 

be around 25+/-1 V. If the result shows abnormal voltage levels, contact 

SKF’s Technical Support Group TSG for assistance. 

 

Note: ICP® is a registered trademark of PCB Piezotronics Europe GmbH in 

Germany and other countries. 

http://www.skf.com/cm/tsg
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• Delete Route  

 

1. Select a Route from the Route manager list.  

2. Select Tools > Delete route to delete the selected Route.  

 

  

3. A pop-up window with a numeric keypad will open. Enter the code shown in 

the title bar to confirm the deletion. 
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• Clear data  

 

1. Select a Route from the Route manager list.  

2. Select Tools > Clear data to clear the measured data in this Route.  

3. A pop-up window with a numeric keypad will open. Enter the code shown in 

the title bar to confirm the data clear. 

 

 

 

• Sensor Manager – With Sensor manager, you can add, delete, or edit 

sensors you use with the data collector. Select Tools > Sensor Manager to 

display the Sensor Manager window. 

 

Figure 13 Sensor manager – example 

• Sensor List – The upper part of the window shows the Sensor List, which 

contains the available sensors in this Route.  

Note that there are two categories of sensors. The first category includes the 

sensors from the Route, which are Route dependent and can only be edited 

but not deleted. The second category includes the custom-built sensors in 

this Data Collector, and they can be used by all Routes. The name of a 

custom-build sensor is marked with an asterisk (*) sign. 
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• Attribute – Select a sensor to view the sensor attributes under Attribute in 

the lower part of the screen.  

 

• New – Tap New to add a new sensor to the list, then fill in the sensor 

information into each column of the Attribute section. 

The sensor information includes: 

o Sensor Name will only be shown in the sensor selection menu of a 

measurement Point. 

 

 

o Description – Fill in a description of the sensor when necessary.  

 

o Type – Select a sensor type from the pop-up menu. 

 

  

o Unit – Select the unit of the sensor. The available sensor units 

depend on the sensor type you have selected. The sensor unit will be 

used to specify the sensitivity as mV / (Sensor Unit). 

 

o Couple – Select DC or AC couple for the sensor. The AC couple 

tends to remove the DC offset of the measured signal, while the DC 

couple retains the DC offset. For example, if the shaft centreline is 

measured from an Eddy Current probe, select DC couple to retain the 

DC value. 

 

o Sensitivity (mV/Unit) – Fill in the sensor’s sensitivity value(s)  
mV / (Sensor Unit) 

 

o SN – Fill in the sensor’s serial number 
 

o Model – Fill in the sensor’s model name  
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o Offset – Fill in the offset value of a DC couple sensor in mV. The 

offset value defines the sensor’s zero point. For example, if the offset 

is 1000 mV, then a measured value of 1000 mV corresponds to  

0 Sensor Units. 

 

 

 

o ICP – enable or disable the ICP power. If the ICP power is checked, 

the data collector will provide the ICP power to the sensor when 

measuring a signal. 

 

 

 

Select Save to save the new sensor to the list or select Cancel to abort the 

procedure. 

 

 

 

• Edit – Select to edit the attributes of the selected sensor. Click Save to save 

the changes.  

 

• Delete – Select to delete the selected sensor. 

Note that those sensors created from the TCT software can’t be deleted. Only 
the sensors created in the Data Collector can be deleted. 

 

Tap Back to exit the Sensor Manager view. 

 

Tap Exit to exit the Data Collector module. 
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2.2.5 Version information 

Tap the information icon  at the top right corner to display the version 

information. 

 

 

Figure 14 About window – example 
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2.3 Navigating a Route display 
 

After you select and enter a Route from the Route Manager view, you’ll see the 
Route display. 

The Route display shows the Route hierarchy, node information, note table or the 

history data table. Use the navigation keys to move the cursor to a selected node.  

2.3.1 Route Display of a Plant, an Area, or a Train node 

 

When the cursor is on a plant, an area, a train or a machine, the display will show the 

Route hierarchy on the left side, the node information on the middle and the Notes 

table on the right side.   

 

 

Figure 15 Display of a route when the cursor is in a Plant, an Area, or a Train  

1. Route hierarchy 

2. Node information 

 

3. Notes table 

4. Menu buttons 

  

 1  2

 4

 3
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2.3.2 Route display of a Machine node 

 

When the cursor is on a machine, the display will show you the Route hierarchy on 

the left side, the node information on the middle, the machine attribute (RPM, 

Pulses/Rev and NFC code) and the Note table on the right side. 

 

 

Figure 16 Display of a Route when the cursor is on a Machine. 

1. Route hierarchy  

2. Node information 

3. Machine attribute  

(Rated speed, NFC 

information) 

4. Notes table 

5. Menu buttons 

2.4 Working with the Route hierarchy 
 

Use the navigation keys or the touch screen to move the cursor on the Route 

hierarchy to select a node and display the node property or perform measurements. 

 

Microlog dBX provides only four levels of hierarchy in Data Collector: 

Plant, Area, Train, and Machine. 

 

If a Route contains machines with greater hierarchy levels than four, the host 

software will automatically use the lower four levels and omit the higher ones to 

preserve the hierarchy structure closest to the machine level. 

  

 1  2  3

 4

 5



DATA COLLECTOR MODULE 

Working with the Route hierarchy 

32 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E  

 

Sub-machines (@ptitude Observer only) 

Microlog dBX does not handle sub-machines (machines within machines) since 

machines in the Microlog dBX may only contain Points, not other machines. 

 

To bypass this, the host software will take all Points from sub-machines and program 

them as immediate children of the parent machine. Each Point will include the name 

of the parent sub-machine in its name. 

 

This modification does not affect the host software - all measurements collected for 

Points within sub-machines will be uploaded to the correct location. 

2.4.1 Expand or collapse a selected hierarchic level  

 

Tap an icon on top of the Route hierarchy to expand or collapse the desired 

hierarchic level.  

 

 

Expand or collapse Area level. 

 
Expand or collapse Train level. 

 

Expand or collapse Machine level. 

 

Expand or collapse Point level. 

 

With these icons of hierarchic levels, you can fast find an area, a train, a machine, or 

a Point from the Route hierarchy.  
 

 

Figure 17 From right to left: Area, Train, Machine and Point level 
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• Expand a node – Move the cursor to a node which is indicated by a “+” icon 
and press the right navigation key to expand a node. To move to the next 

node, press the right navigation key again. 

• Collapse a node – Move the cursor to a node which is indicated by a “-” icon 
and press the left navigation key to collapse a node. To move to the previous 

node, press the left navigation key again.  

2.4.2 Read the alarm status from the Route hierarchy 

 

At the right side of each node in the Route hierarchy, there is a square indicator 

showing the alarm status of that node.   

 

 

You can read the alarm status by the colour and form of the indicator: 

 

• White  – No data.  

 

• Green  – All the latest measured data in this node or all its child nodes are 

in normal status. Note that if the measured data is not set with alarm level(s), 

it will be shown with a green indicator. 

 

• Green  – Skipped machine. 

 

• Yellow  – At least one of the latest measured data in this node or all its 

child nodes is in alarm 1 status. 

 

• Red  – At least one of the latest measured data in this node or all its child 

nodes is in alarm 2 status. 
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2.4.3 Alarm types 

 

The Data Collector module supports the detection and display of various alarms:  

 

• Above alarm  

• Below alarm  

• In window alarm 

• Out window alarm  

 

The alarm status is displayed on a bar chart with different colours: 

 

• Green – normal  

• Yellow – alert  

• Red – danger 

 

 

Figure 18 Bar plots with various types of alarms on the background 

• Above alarm – A measured value higher than the alarm value(s) is detected 

as Alert (yellow) or Danger (red). 

• Below alarm – A measured value lower than the alarm value(s) is detected 

as Alert (yellow) or Danger (red). 
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• In window alarm – A measured value inside the specified range is detected 

as Alert (yellow) or Danger (red). 

 

 

• Out window alarm – A measured value outside the specified range is 

detected as Alert (yellow) or Danger (red). 

 

2.4.4 Take a picture of a node 

 

If there is a picture associated with the selected node, it will be displayed in the 

middle of the Route display.  

 

Tap Take a picture to activate the camera on the back of your Microlog dBX, take a 

picture of the area, train or machine and save it to the database.  

The saved picture files are in JPEG format. On upload of the Route, they will be 

saved to a folder on the host computer.  

 

Note: If you delete a Route and upload it again, the saved images will be lost. To 

avoid this, do a Route reset instead. Route reset is possible from Microlog dBX and 

TCT.dBX. 

 

Refer to the TCT.dBX Instruction Manual for more information on how to configure 

where photos and Non-Point notes will be saved. 

2.4.5 Working with Note(s) at Non-Point nodes 

 

When the cursor is on a Non-Point node, you can add a note or several notes with a 

piece of text or a picture to describe the abnormal behaviour of the machine.   

 

• Add note – Add note to an area, a train, or a machine. Note is part of the 

archive data and is time dependent. A note is either pre-coded from the 
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@ptitude Analyst or created from the Data Collector module. You can add 

note(s) to a machine as a memo of the machine condition. 

 

 

Figure 19 Add note  

Tap Notes to display the list of pre-coded notes, move the cursor to select a coded 

note and save it. Or you can select Add Note to display the keypad and input a string 

to create a new note. The created Note will be saved to the note list for future use. 

 

 

Figure 20 Add note keypad  



DATA COLLECTOR MODULE 

Working with the Route hierarchy  

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

37 (235) 

 

 

Tap Take picture to activate the camera and take a picture. The picture will be 

saved as part of the note record. Tap Delete picture to delete a picture. 

 

 

Figure 21 Add note  

Tap Save to save the note and close the window. 

 

• Delete a note – Tap the note to enter the edit note page and select Delete.  

 

• Delete all notes – Tap to delete all saved notes. 

 

 

 

  



DATA COLLECTOR MODULE 

Working with the Route hierarchy 

38 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E  

 

2.4.6 Using the NFC reader 

 

With the built-in RF identification using near-field communication NFC located on the 

rear, you can quickly locate a machine by scanning the NFC tag installed at the 

corresponding location.  

 

Move the cursor to a machine to check whether there is an NFC code in the 

Attribute section. 

 

 

Figure 22 NFC information  

If the NFC code is stored in the specific node, you can scan the corresponding NFC 

tag and move the cursor to that node. Select the following options from the Tools 

menu to work with the NFC feature: 

 

• Add NFC – Add an NFC code to the specific node. Select this function to 

activate the NFC reader. Scan the NFC tag, which is installed to the physical 

location of the node and store the NFC code to the Route. 

 

• Read NFC – Scan the NFC tag and move the cursor of the Route hierarchy 

to the corresponding node. 

 

• Delete NFC – Delete the NFC code which is stored in this node. 
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2.4.7 Skip a measurement 

 

Place the cursor on a machine node in the Route hierarchy and select Skip from the 

Tools menu to skip the measurement. It will prompt you to add a note for this skip 

action. 

 

                      

         

 

 

The skipped machine and all its child nodes will be marked with a triangle indicator to 

show the skip status. This function is usually used when the machine is not 

operating.   
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2.4.8 Route display of a Point 

 

When the cursor is on a Point or a direction of a Point, the display will show you the 

hierarchic database on the left side, the Point and sensor information in the middle 

and the archive data table on the right side.   

 

 

Figure 23 Display of a Route when the cursor is on a Point 

1. Route hierarchy 

2. Node information 

3. Sensor selection 

4. Sensor plot 

5. History data table 

6. Measurement panel, see MPA 

section 

7. Menu buttons

 

2.4.9 Multiple Point Automation (MPA) and Route Points 

 

Points downloaded in a Route which are members of an MPA (Multiple Point 

Automation) group will be displayed as a single Point in the Route hierarchy. 

 

When you click Measure for a Point made from an MPA group, a raw data sample 

will be taken as normal, and then the raw data will be processed into measurements 

for all the Points in the group. 

 

The Measurements panel in the middle of the Route screen will show the 

measurements for each of the Points that formed the group, and when data is 

collected, these will appear as separate plots in the measurements screen. 

 

 1

 2

 3
 4

 5
 6

 7
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2.4.10 Working with Note(s) at a Point node 

 

The note(s) of a Point is part of the data record.  

As you move the cursor on the history data table, it will show you the corresponding 

record note(s) in the node information table in the middle of the display. 

 

Figure 24 Notes – example  

1. Note inside 2. Note content

 

Follow one of the methods below to add a note to a data record. See Working with 

Note(s) at Non-Point nodes for detailed description. 

 

Add a note after a measurement  

After taking a measurement and before saving the new record, you can add a note to 

it from the Add note menu. 

 

Figure 25 Add note 

 1

 2
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Add a note to a selected record from the History data table  

Browse through the History data table, select a record and tap Add a note to add a 

new note to this record.   

 

Tap Back to return to the Route manager view. 

2.5 Data measurements  
 

The following chapter describes how to install a sensor and how to take 

measurements within a Route. 

2.5.1 Reset hierarchy status  

 

When you start a new measurement task with a selected Route, select Reset 

hierarchy status from the Tools menu of the Route.   

 

 

This option will display Reset hierarchy status since YYYYMMDD with a time 

stamp pre-set as the current date and time. You can also input a different time stamp 

manually if wanted. 

 

 

Tap Enter to confirm the reset.  
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The hierarchy status of the data measured before the time stamp will be cleared.  

 

Figure 26 Reset hierarchy status   

Note: It is recommended to reset the hierarchy status before performing a new 

measurement task to see if a Point is measured or not.   

2.5.2 Sensor connection 

 

Before taking a measurement, connect a suitable sensor to your Microlog dBX and 

install it in the correct position and direction. 

 

Figure 27 Back view connections 
  

• Uniaxial accelerometer – Connected to Channel 1 (Connect to the All CH 

Fischer connector with a proper cable/connectors).  

 

• Dual axis sensors – Always connect to Channel 1 and Channel 2.  

 

• Triaxial accelerometer – Connected to Channel 1, 2 and 3 for 

measurements of axial, horizontal and vertical directions. (Connect to the All 

CH Fischer connector with a proper cable and connectors). 

 

• DC sensor – Connected to channel 4. (Connect to All CH Fischer connector 

via an appropriate cable). 

 

• Speed sensor – For AC type speed sensor, always connect a speed sensor 

to the PWR/TRIG connector with a proper cable/connectors.  

For the DC-type speed sensor, connect to Channel 4. 
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➢ An AC type sensor generates a pulse per revolution signal. It includes 

the signal from an SKF laser tachometer or an ECP sensor (Eddy 

current probe).  

Note: If the peak value of the speed signal is lower than 2.5 V, it will 

not trigger the speed measurements. 

 

2.5.3 Sensor selection 

 

Select a sensor from the sensor selection menu before performing a measurement. 

 

 

 

Tap sensor selection to display the list of available sensors and use the navigation 

keys to select one.  

 

Note: Only sensors of the same type will be displayed in the list.   

 

 

 

2.5.4 Sensor types and sensor installation 

 

DC sensor 

A DC sensor Point can be identified from the illustrating icon at the up-right corner. 

The DC-type signal includes temperature, pressure, flow, voltage, current and others. 

It is always connected to Channel 4 from the BNC connector or the All CH connector 

with an appropriate cable.   
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Figure 28 Process type – example  

1. Plot illustration of a DC sensor  

 

Manual parameter 

For a manual parameter Point, you will need to input a numerical value manually 

after you tap Measure. The manual parameter Point can be identified from the 

keypad icon at the up-right corner. 

 

 

Figure 29 Process types – example  

1. Manual parameter input – example  

 1

 1
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Uniaxial sensor 

A uniaxial sensor contains neither location nor directional information inside. Usually, 

the information on the sensor location and direction is indicated by the name of the 

Point.  

For example, a Point named MOV may indicate that the sensor is installed in the 

vertical direction of the Outboard Point of a Motor. 

You can tell whether it is a Uniaxial Point from the plot illustration in the up-right 

corner. 

 

 

Figure 30 Process FFT – example  

1. Plot illustration of a uniaxial sensor 

 

Dual axis sensor 

When a dual axis sensor is used, it will show a plot illustration of the dual axis sensor 

in the top right corner. A dual axis sensor is a pair of sensors with which you can 

measure the Orbit of a rotating shaft in addition to the other general functions. 

When a Point is set up to measure Orbit, the locations of the two sensors will be 

shown at the top of the sensor plot illustration. 

 

 1



DATA COLLECTOR MODULE 

Data measurements  

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

47 (235) 

 

 

 

Figure 31 Dual channel – example  

1. Plot illustration of a dual axis sensor 

 

 

Figure 32 Locations from a dual axis sensor used for orbit measurements 

Triaxial accelerometer 

When a triaxial sensor is used, it will show an illustrating plot of a triaxial sensor in 

the top right corner. A triaxial sensor contains location information and direction 

because the measured data from the 3 axis needs to be assigned to horizontal, 

vertical, and axial directions in a proper way. 

You can always follow the default setting to install the sensor. In case the sensor 

installation is not possible due to some restriction, you can change the sensor 

installation to match your way of installation.  

 

 1



DATA COLLECTOR MODULE 

Data measurements 

48 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E  

 

 

Figure 33 Plot illustration of a triaxial sensor 

2.5.5 Speed measurement 

 

When a machine node is marked with an S symbol, that implies there is a speed 

Point(s) under this node. Measure the speed Point(s) before measuring the other 

Points.  

  

2.5.6 Measure speed from an AC-type sensor 

 

For a speed Point which measures the speed from an AC-type sensor, such as an 

SKF laser tacho sensor or an ECP sensor, it will show the following display. 

 1
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Figure 34 Speed tagging from AC-type sensor – example  

Note that the AC-type speed signal is always connected to the PWR/TRIG connector.  

Move the cursor to the speed Point under the machine and press the Start / Stop 

key to display the speed measurement window. 

 

 

Figure 35 Measuring speed – example  

Tap Confirm or press the OK key to complete the speed measurement.  

 

Tap Abort to abort the measurement. You can also select Edit from the speed 

measurement display to enter a speed value manually. 
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2.5.7 Measure speed from a DC-type speed sensor 

 

If a Point is set to measure the speed via a DC-type speed sensor, it will show the 

following display. 

 

Figure 36 Speed tagging from DC-type – example  

Connect the signal to Channel 4 and tap Measure to start the measurement. 

2.5.8 Measure speed via manual input 

 

If a Point is set to measure the speed via manual input, it will show the following 

display. 

 

Figure 37 Measure speed – manual input – example  
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Tap Measure and enter the speed value in the numerical keypad located in the up-

right corner of the display. 

2.5.9 Measure speed using speed tagging 

 

If a speed Point is set as speed tagging, it will measure the vibration spectrum from 

which you can tag the 1X as the rotation speed.   

 

1. Connect the vibration signal to Channel 1 and then tap Measure to start the 

measurement.  

        

 

2. After the vibration measurement, the cursor of the spectrum plot will stay at 

the maximum peak. Move the cursor to the 1X position if the 1X is not at the 

maximum peak and tap Save speed to save the cursor value as the speed.  
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2.5.10 Speed ratio and ratio speed 

 

When the speed Point(s) is measured, the speed value will be applied to other 

measurement Points of the same train by multiplying the pre-set speed ratio to 

generate the ratio speed(s). Note that the speed Point(s) always need to be 

measured first.  

 

Otherwise, it will prevent you from measuring other points and display the following 

warning message. 
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2.5.11 Rotation speed 

 

The rotation speed of a machine is presented in the top left corner of a spectral plot 

or a waveform plot.  

 

Figure 38 Rotation speed of a machine 

The speed value may come from three sources: 

 

• Rated speed – The rated speed is part of the machine attributes, which are 

defined by the host software. If there is no measured speed for the machine, 

the rated speed will be shown at the speed corner. 

 

• Measured speed and ratio speed – The measured speed(s) is derived from 

the measurement of a speed Point. The other measurement Points under the 

same machine train can convert it into different speed values by applying the 

speed ratios. This feature makes it easy to derive individual speed values 

when there is a transmission mechanism in a machine train. When a Point 

contains a measured speed or ratio speed, it will replace the rated speed.  

 

• Tagged speed – To tag a speed value, move the cursor to a selected 

frequency on a spectral plot and select Set as 1X from the View menu. The 

tagged speed value is used for that measurement Point and applies to other 

measurement functions under this machine. If you select Clear 1X from the 

View menu, the speed value will restore to the rated speed. 

2.5.12 Order tracking Points 

 

If a Point contains order tracking measurements, it will require you to measure the 

speed with an AC-type speed sensor first.  

The measured functions derived from the order tracking algorithm include Order 

spectrum, Phase spectrum, Amplitude, Phase and Orbit. 
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Alternatively, if an AC-type speed signal is not available, but the reference speed is 

measured from a speed tagging Point in advance, the software will conduct an order 

normalisation algorithm to provide an order spectrum with no phase information. 

 

If neither the AC-type speed sensor nor the speed tagging Point is available, the 

order tracking measurement will be aborted. 

2.5.13 Acquisition of raw data 

 

Move the Route hierarchy cursor to a measurement Point and press the Start / Stop 

or the Measure key to start a measurement.  

2.5.14 Measurement modes  

 

Auto 

If the measurement mode is set as Auto from the Configuration window, the 

measurement will start right after the Start / Stop key is pressed. The Data Collector 

module will acquire the raw signal and show it with waveform plots and percentage 

status of the measurement progress.    

 

 

Figure 39 Measurement example – Auto 

Manual 

If the measurement mode is set as Manual from the Configuration window, it will 

display a live view of the measured signal after the Start / Stop key is pressed.  

 

Note that the measurement will not start until the OK key or OK button on the screen 

is pressed. Using the manual mode, you can observe the signal before starting a 

measurement. 
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Figure 40 Measurement example – Manual 

2.5.15 During data measurement 

 

During data measurement, the time waveform is displayed with the progress 

percentage number at the bottom. 

 

 

Figure 41 Single axial measurement 
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Figure 42 Dual channel measurement 

 

 

Figure 43 Triaxial measurement 

2.5.16 Channel status during a measurement  

 

The channel status is shown on top of the display with channel status icons. The 

channel status shows the channels which are in use: 
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Channel Status:  3 channel measurement 

Channel Status:  Dual channel measurement 

Channel Status:  Single channel measurement 

2.5.17 Measurement abort 

 

When an abnormal ICP bias or overloaded signal is detected during the 

measurement, the software will abort the measurement automatically and display a 

message showing the errors. 

 

 

Figure 44 Overloaded signal – example 

2.5.18 Complete a measurement 

 

The time it takes to complete the raw data acquisition depends on the 

measurement’s setup. For example, it takes around five seconds to complete a 
measurement with the following setup: 

 

 Power spectrum x1 

       Bandwidth = 2 kHz 

       Resolution = 3200 lines 

       Average = 5 times, with 50% overlapping 

 Time waveform x1 

 Overall velocity x1 

 gE (true peak-to-peak) x1 

 gE envelope spectrum x1 

 Band overall x5 



DATA COLLECTOR MODULE 

Data measurements 

58 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E  

 

 

Figure 45 Measurement example 

After the raw data acquisition is completed, it will be converted into various pre-set 

functions in the Route.  

 

Tap Save to complete this measurement or select Abort to abort this measurement. 

To add a note to this record, tap Add note before saving it. 

When the measurement results in more than six plots, tap Next to enter the next 

page for more information. 

  

 

Figure 46 Measurement example 
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2.5.19 Manual parameter 

 

The manual parameter must be entered manually. Tap the input field to display the 

keypad and input the data.  

 

 

Figure 47 Manual parameter input 

2.6 Non-Route measurements 
 

The Non-Route measurement feature allows you to take a measurement which is not 

previously defined in the Route and downloaded to the Microlog dBX. The Non-Route 

measurement is useful when additional measured data is required to perform further 

analysis of the root cause of a vibration problem. 

2.6.1 Activate a Non-Route measurement 

 

Move the cursor of the route hierarchy to a machine or a Point, and the Analyzer 

button will display on the main menu. Tap the Analyzer button to activate a Non-

Route measurement for that node.  

Note that the hierarchy information of the selected node, either a machine or a Point, 

will be saved together with the measured data. Ensure the cursor is at the correct 

node where the Non-Route measurement will be taken. 
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Figure 48 Analyzer menu button  

Tap the Analyzer button, and the software will prompt a dialogue box showing that it 

will leave the Data Collector module and enter the Analyzer program for collecting a 

Non-Route measurement. 

 

 

 

Tap Yes to enter the Analyzer module or select No to abort 

2.6.2 Take a Non-Route measurement from a template 

 

When the Non-Route measurement is activated, the software will prompt you to 

select a testing template or the Analyzer from the following display. 
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Figure 49 Templates for Non-Route measurements   

1. Analyzer – Tap to enter the Analyzer module and take a non-template 

measurement. 

 

2. Standard templates – Tap to enter the Analyzer module with pre-set 

parameters of a standard template.  

 

3. User-defined templates – Tap to enter the Analyzer module with pre-set 

parameters of a user-defined template. 

 

Select a standard or user-defined template to quickly perform a test with pre-set 

parameters. 

2.6.3 Standard and user-defined test templates 

 

• Standard templates – Provided by SKF and are pre-set with the most 

common measurement parameters for taking a measurement quickly. The 

standard test templates are shown with specific icons.  

 

The standard templates include Bump Test, gE Enveloping, Order 

Tracking and Orbit Analysis. For more information about these standard 

templates, refer to Perform test from a pre-set template for detailed 

instructions. 

 

• User-defined templates – In addition to the standard templates, you can 

create and use your user-defined templates from the Analyzer module. These 

user-defined test templates are project files and are saved in the following 

folder: D:\dBX\Microlog dBX\Analyzer\Data_Collector\.  

 

 1  2  3

 3
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As the Non-Route measurement is activated, the software will search for 

Analyzer project files in that folder and show them on the template display 

together with the standard templates. User-defined templates appear on the 

screen with the same icon. 

2.6.4 Take a Non-Route measurement without template settings 

 

If none of the templates are suitable for your non-route measurement, you can select 

Analyzer for taking a Non-Route measurement. Selecting Analyzer will run the 

Analyzer module with the default settings for a new project, and you’ll need to go 
through the setup process to create a new test project. For detailed instructions, refer 

to the dBX Analyzer module chapter.  

2.6.5 Complete a Non-Route measurement  

 

After taking the Non-Route measurement from the Analyzer module,  

select File > Save data and return to complete the measurement and return to the 

Data Collector module. 

 

 

Figure 50 Save data  

The software will prompt you to save the data to a file in the Analyzer format. You 

can review the saved data from the Analyzer module later.  

It will also save the data to a UFF (Universal file format) file in a specific folder. The 

UFF file will be uploaded to the host software on your computer when the archive 

data is uploaded to the computer.  
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Figure 51 Save data – example   

Note that only measured functions that are supported by the host software, SKF 

@ptitude Analyst, will be uploaded to the computer. Supported functions: Analyzer, 

gE, Bump test and Orbit. 

Not supported measured functions can be reviewed from the Analyzer software. 

2.6.6 How to create a user-defined template 

 

To create a user-defined test template for Non-Route measurement: 

 

1. From the home screen, double tap the SKF Analyzer icon or select a test 

template. 

 

2. Set up or modify the measurement parameters and the display layouts.  

 

3. Select File > Project > Save as to save this project. 

 

4. Select the following folder path:  

D:\dBX\Microlog dBX\Analyzer\Data_Collector\. 

 

Next time you activate the Non-Route measurement, these saved projects will be 

shown as a user-defined template. 

For more information, refer to the dBX Analyzer module chapter.  

2.6.7 How to review Non-Route data 

 

To review a Non-Route data using the Analyzer module, follow this instructions: 

 

1. From the home screen, double tap the SKF Analyzer icon. 

 

2. From the main menu, select File > Data File > Add to open the Select Disk 

dialog. 
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3. From the Open Dialog window, locate and select the data file. Tap the Open 

button to open the file.  

 

 

 

4. Now you can locate the added data from the History panel. Select a function 

and press OK to display it on the plot area.  

 

 

For further instructions, refer to the dBX Analyzer module chapter. 
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2.7 Multiple Point Automation (MPA in a Flash) 
 

The Microlog Analyzer dBX allows the user to configure up to 12 measurements 

for automatic data collection at one measurement Point. Using the same sensor, the 

user needs to press only one button to sequentially collect all pre-configured MPA 

measurements.  

 

MPA Point rules 

Points in an MPA group should adhere to the following: 

 

• There must be more than two Points in an MPA group. 

• All Points must have the same coupling. 

• The same sensor must be used for all Points. 

2.7.1 MPA Route setup 

 

To set up an MPA Route 

 

• In your host software, such as @ptitude Analyst, access the Point Setup 

screen and use the Description field to identify MPA Points. The first 

characters in the Description field identify the MPA group to which the 

configured Point belongs. For MPA Points, the first character in the 

Description field must be "@”. The “@” character must be followed by one or 

more alphanumeric characters that identify the group of MPA Points. 

 

The characters following the “@” in the Description must be identical for each Point 

in the MPA group. For example, 
 

@MT1 VELOCITY,  

@MT1 ACCEL  

@MT1 ACC ENV  

 

are legal Descriptions for three MPA Points collected at the same location on a 

motor.  

 

For three additional Points collected at a second location on the motor,  

 

@MT2 VELOCITY,  

@MT2 ACCEL  

@MT2 ACC ENV  

 

might be appropriate Descriptions. 
 

MPA codes can be of any reasonable length, so the following setup is acceptable:  

 

@MT31137 Motor NDE H VEL, 

@MT31137 Motor NDE H ACCEL 

@MT31137 Motor NDE H ACC ENV 
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Note that when MPA Points are downloaded to the Microlog dBX, they are combined 

into a single route Point. You may see the names of the original Points and their 

measurement parameters in the Measurements panel when the Point is selected. 

 

The name of the single route Point containing MPA Points is determined as follows: 

 

• If there is a common root to the Point names, it is used as the start of the 

MPA Point name. 

 

• If there is no common root name, the name of the first point is used as the 

start of the MPA point name. 

 

• The name of the MPA group is then appended to this name. 

 

In the above example, this would result in an MPA Point named Motor NDE H - 

@MT31137 

 

If more than 12 Points are defined, Microlog dBX collects data for the first 12 MPA 

Points, and the remaining MPA Points are ignored. 

2.8 Data review  
 

Move the cursor to a Point which has history data stored and press OK to enter the 

archive data table. Press the C key or the Back button to go back to the Route 

hierarchy. 

 

 

Figure 52 Archive data  
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When the cursor is on the history data table, use the navigation keys to move the 

cursor to the selected date and time. Press OK to enter the archive data display. 

 

 

Figure 53 Date and time of a history data record 
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2.8.1 Multiple plots and single-plot display 

 

In a multiple plot display, up to six plots at a time can be shown. Overall plots are 

prioritised, and the remaining plots presented are ordered depending on the setup. 

 

If there are more plots, select Next to enter the other pages. You can display a 

selected plot in a single-plot display by maximizing it for in-depth data review.  

 

• Active plot – You can always access an active plot which has a blue title bar 

on the top. The inactive plots have grey title bar colour. Tap on a plot to 

select and make it active. 

 

Figure 54 Active and inactive plots – example 

Alternatively, press the C key to enable the active plot selection. It will change the 

title bar colour of the active plot into red. Then you can use the navigation keys to 

move the red bar to another plot and press C to disable the selection mode. 

 

Figure 55 Red colour title bar example 
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• Maximise or restore an active plot –Press the OK key to maximize an 

active plot and press OK again to restore it. 

Alternatively, tap the Maximise caption button on the right side of the title bar 

to maximize or restore a plot. 

 

 

Figure 56 Maximise plot icon 

 

Figure 57 Minimize plot icon 

• View menu and right click menu – To display a plot with different settings 

or formats, use the View menu. You can also use the right-click key to 

display the pop-up menu for option selection. Note that the contents of the 
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Right click menu and View menu are identical. 

 

     

Figure 58 View menu (left) Right-click menu (right)  

2.8.2 Overall plot 

 

The Overall plot contains all the single-value data, such as overall, band overall, gE 

level, temperature, etc. 

 

• Bar plot – Each value is displayed as a bar with its label on it. Note that all 

the bars are normalised by their Alarm 1 values, hence they are 

dimensionless data shown as percentages on the plot. With this 

arrangement, you can read the alarm condition of each value very quickly. 

The readings higher than 300% of the alarm 1 have their bars clipped. To 

read the real value of each bar, move the cursor using the navigation keys or 

tap on a bar to show it on the cursor value field. 
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Figure 59 Bar plot – example 

1. Cursor value 

2. Percentage 

3. Danger 

4. Alert

 

• Trend plot – Move the cursor of a bar chart to a selected bar, then tap View 

to select Trend plot from the menu. 

 

To restore to bar plot display, select Overall plot from the View menu. 

 

Figure 60 Trend plot 

 4

 3

 2 1



DATA COLLECTOR MODULE 

Data review 

72 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E  

 

2.8.3 Waveform plot 

 

Displays time waveform or gE waveform data with various layouts and formats. 

Select different options from the View menu. 

 

• Overlap and separate display – Time waveforms of the multiple directions 

are shown in one overlapped plot.  

 

 

Figure 61 Time waveforms – Overlapped view 

Select Separate from the View menu / Y plot mode to change it to a separate plot. 

 

Figure 62 Three separate plots example 
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• Time waveform plot view menu  

 

 

 

o Cursor – Select Cursor type. 

o Y-axis – Set the scale of Y axis as auto or fixed. 

o X-axis – Set the scale of X axis as auto or fixed. 

2.8.4 Spectral plot 

 

There are two types of spectral data Spectrum and gE spectrum. Select different 

options from the View menu to display spectral data with various layouts and 

formats. 

2.8.5 View menu of spectral plot 

 

For detailed information on spectral cursors and how to use them, refer to Working 

with cursors. 

 

• Set as 1X – Move the cursor to a selected frequency and set it as 1X. It will 

set the cursor frequency at 1X (rotational speed) of this spectrum.  

 

Note that the tagged 1X value overwrites the ratio speed of this Point and is 

applied to all the other measured functions under this Point. 
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Figure 63 Set as 1X (Right), Clear 1X (Left) 

• Clear 1X – Clear the 1X setting and restore back to the rated speed. 

 

• Cursor – Select cursor type. 

 

• Y-axis – Set the scale of Y-axis as Auto scale, Fixed scale, Linear scale, or 

log scale. 

 

• X-axis – Set the scale of X-axis as Auto or Fixed scale. Display the X-axis 

unit in Hz, CPM or Order. 

 

• Y-plot mode – Separate and overlap – Displays the spectral data of the 

multiple directions in separate plots or an overlapped plot by selecting one 

from the View / Y-plot mode menu. 

 

 

Figure 64 Spectral plot – example 1 
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Figure 65 Spectral plot – example 2 

• Unit – Perform a unit conversion for the plot.  For example, if the data is 

measured in velocity, you can select to display it in other velocity units: mm/s, 

in/s, or cm/s.   

Note that the converted units are used for display purposes only, and it will 

not overwrite the measured data.  

 

• Plot – Display the historical spectra data in waterfall plot.  

 

 

Figure 66 Waterfall plot – example 

• Show / Hide 1X – Select to show or hide the 1X. 

• Show / Hide band alarm – Select to show or hide the band alarm. 

• Show / Hide fault frequency – Select to show or hide the fault frequency. 
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2.8.6 View menu of waterfall plot 

 

 
 

• Cursor – Select a cursor type from X, Y, and X+Y. 

• Y-axis – Set the scale of Y-axis as auto or fixed. 

• X-axis – Set the scale of X-axis as auto or fixed. 

• Spectrum – Return to the single spectra plot. 

 

2.8.7 Show or hide band alarm 

 

Show or hide the band alarm curves on the spectral plot. Note that the band alarm 

display is available only when the plot mode is set as Separate.  

  

 

Figure 67 Show / Hide alarm curves 

2.8.8 Show or hide fault frequency  

 

Show or hide the fault frequencies on the spectral plot.  
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Figure 68 Show / Hide fault frequency – example 

2.8.9 Complex spectral plot 

 

A complex spectrum contains both amplitude and phase information. The Data 

Collector module has two complex spectrum functions available: 

 

• Order spectrum – The Order spectrum is measured with a digital order 

tracking algorithm. It provides the amplitude and the phase data concerning 

the speed sensor.  

   

• Phase spectrum – The Phase spectrum is measured with a trigging signal 

from the speed sensor. It provides the amplitude and phase data. Unlike the 

Order spectrum, the phase spectrum is derived from a regular FFT 

calculation. Phase spectrum is only available as part of Order Tracking Point. 
 

 

Figure 69 Cross Spectrum – Amplitude (upper screen) and Phase plot (lower screen) 



DATA COLLECTOR MODULE 

Data review 

78 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E  

 

Move the cursor to a selected frequency and zoom in to see the details. You can see 

the phase reading from the cursor value table. 

 

 

Figure 70 Cross Spectrum – Zoom 

2.8.10 View menu of a complex spectral plot 

 

 
 

For more information, see the description in section Complex spectral plot. Note that 

the band alarm curves, fault frequency display and waterfall plot of a complex 

spectral plot is not available from the View Menu. 
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2.8.11 Orbit plot 

 

Display orbit plot with various options and settings. Select different options from the 

View menu. 

 

 

Figure 71 Orbit plot – example   

On top of the orbit plot, the following parameters are shown Speed, Filter, DC Gap 

Value, and Cursor values. 

 

• View menu of Orbit plot 

 

 

 

o Cursor – Select type of cursor from Point or Revolution. Select 

Revolution cursor to highlight one revolution at a time. 

 

o Filter – Select a filter from the options below. 
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Select Custom to set the minimum and maximum custom filter values. 

  

 

 

o Revolutions – Select the number of revolutions for the plot. 

2.8.12 Manual parameter  

 

Display a manual parameter in trend plot or single Point format by selecting an option 

from the View menu.  

 

  

Figure 72 View manual parameter – example 
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2.8.13 Amplitude and phase plot 

 

Note: This plot can only be used when programmed from @ptitude Observer. 

 

The amplitude and phase plot shows the amplitude and phase data of a specified 

order, such as 1X or 2X, on a polar plot. 

Amplitude and phase plot is only available as part of Order Tracking Point.  

 

Figure 73 Amplitude phase – example 

• View menu of amplitude and phase plot – Select to display trend plot or 

single Point plot. 

 

Figure 74 Amplitude phase trend – example 
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• Show or hide a direction on a plot – To show or hide a direction on a 

spectral or waveform plot, tap the check box at the top of the plot. 

 

 

Figure 75 Show direction on a plot 

 

Figure 76 Hide direction on a plot 

2.8.14  Working with cursors 

 

Select a cursor   

Select the type of cursor for navigating a spectral plot. Use the  key for quick 

toggling of the cursor type or select a cursor from the Cursor option in the View 

menu. 
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Move a cursor  

 

Use the left and right keys to move a selected cursor or tap on a plot to locate the 

cursor to the tapped point. You can also slide your finger on a plot to move the 

cursor. 

 

Types of cursors: 

 

• Single cursor – Displays only one cursor on the plot. 

 

 

Figure 77 Single cursor – example 

• Harmonic cursor – Displays the harmonic orders of the cursor position.  

 

Figure 78 Harmonic cursor – example 
 

Press the C key to make it possible to move the main cursor to each 

harmonic location and see the cursor value of each harmonic component. 

Press C again to return to a normal mode of a harmonic cursor. 
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Figure 79 Harmonic cursor – example 

• Dual cursor – Displays two cursors on a plot. Tap the D1 or D2 icon to select 

the left or the right cursor and move it. Tap at the middle of the dual cursor to 

move the complete Dual Cursor. 

 

 

Figure 80 Dual cursor  

• Side band cursor – Displays side band cursors. Tap the S1 or S2 icon, then 

use the left or right key to move the side cursors. Tap the S icon and use the 

left or right key to move the centre cursor.    
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Figure 81 Side band cursor  
 

• Jump peak – Make the cursor always stay on a peak. When you move the 

cursor, it will jump from one peak to another. Press the Up key twice to 

enable or disable the move peak function. 

2.8.15 Zoom in, zoom out, auto scale and pan 

 

• Zoom in  – Press the zoom in key to zoom in the plot along the X-axis 

from the point where the cursor is on. You can also place two fingers on the 

plot and move them apart to conduct the zoom-in operation.  

 

• Zoom out  – Press the zoom out key to zoom out the plot along the  

X-axis from the point where the cursor is on. You can also place two fingers 

on the plot and move them together to conduct the zoom out operation. 

  

Figure 82 Zoom in and zoom out a plot 

 

• Auto scale – Double tap at the legend area of the X-axis to auto-scale the  

X-axis. Double tap at the legend area of the Y-axis to auto-scale the Y-axis. 
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Figure 83 Double tap auto scale – example 
 

• Pan – Use two fingers to drag the plot to perform the Pan function and move 

the data trace to the desired position.  

 

 

Figure 84 Pan function – example 

 

Tap Back to return to the Route display. 
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3 Sync Data Collector module  

3.1 Connect Microlog dBX to a computer 
 

1. Using the provided CMAC 9010 (Data Link GT168) USB cable, connect your 

Microlog dBX to the computer’s USB port.  
Note: The connection cannot be established by using a standard USB cable. 

 

 

 

2. Double tap the SyncDataCollector icon from the home screen. 

 Before using the software, please read and understand the separate 

Microlog Analyzer dBX Quick Start Guide. 
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3. On your computer, open the Analyst TCT dBX (Thin Client Transfer).  

4. Select Transfer > Microlog dBX… and check the Microlog Analyzer status If 

the connection has failed, it will show an error message. 
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 For more information about the Analyst TCT dBX, read the separate  

SKF @ptitude Analyst Thin Client Transfer dBX User Manual. 

 For more information about the Data Bridge, read the separate SKF 

@ptitude Observer Data Bridge User Manual. 
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3.2 Connection status 
 

When the connection is successful, it will show a scrolling green dotted line between 

the Microlog dBX and the computer and a Connect successfully message will 

appear in the information section. 

 

 

 

Tap Hide to toggle the information section. 

 

If the connection is failed, the green dash line will turn into a grey colour, and a 

Connection lost message will appear in the information section.   
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3.3 Data transferring status 
 

When data transfer is in progress, a warning message is shown in the middle: 

Please do not disconnect the cable while transfer is in progress 

 

 

3.4 Error message 
 

If connection fails, check the error message, and follow the suggested remedies. 
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Error Message Remedy 

Failed to enumerate USB cable 

devices 

Check if the USB cable is plugged in 

The required USB device index %d 

doesn't exist 

Unplug and re-plug the USB cable 

Unable to get information of device 0 Unplug and re-plug the USB cable 

Unable to open USB cable device Unplug and re-plug the USB cable 

Unable to get connection status Connection missing or failed, unplug 

and re-plug the USB cable 

GetFolder: failed -30 Upgrade TCT.dBX to the latest version 
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4 Balancing module 

4.1 Introduction 
 

The Balancing module is used for balancing various types of rotors on different 

machine types. It contains several balancing software features that fast and easily 

balance the rotors through a step-by-step process.   

 

To start the Balancing module, using the navigation keys, navigate to the SKF 

Balancing icon and press OK or double tap the icon. 

 

 

Figure 85 Home screen – Balancing icon 

 Before using the software, please read and understand the separate 

Microlog Analyzer dBX Quick Start Guide. 
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4.2 Home screen 
 

 

Figure 86 Balancing module home screen 

1. Menu buttons 

 

On the rotor balancing home screen, the following software and options are 

available:  

 

• Single Plane – Single plane balancing on a new rotor, including the trial 

weight process and calculating balancing coefficients. 

 

• Dual Planes – Dual plane balancing on a new rotor, including the trial weight 

process and calculating balancing coefficients. 

   

• Three planes – Three planes balancing on a new rotor as shown in the 

picture, including trial weight process, and calculating the balancing 

coefficients. 

 

• Overhung – Overhung rotor balancing on a new rotor, including the trial 

weight process, and calculating balancing coefficients. 

 

• Four planes – Four planes balancing on a new rotor as shown in the picture, 

including trial weight process, and calculating the balancing coefficients. 

 

• 3 Balancers – Start new balancing job on three permanently mounted 

balancing weights as shown in the picture, including trial weight process, and 

calculating the balancing coefficients. 

 1
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• Continue a saved job – Open a saved file and continue an unfinished 

balancing job with saved coefficients and historical data. It is one of the key 

features when you are in the middle of a large job. 

 

• Redo saved job – Open an existing file where the balancing coefficients are 

saved. 

 

• Exit – Tap to exit the Balancing module. 

 

• Configuration – From this menu the following options are available:  

 

o System Units – Select Metric units or Imperial units. 

 

 

Figure 87 Configuration view – System units 

o Load setup – Tap to open a new window where you can select a 

setup file and load the setup parameters for your balancing job. Note 

that from the extension name of a setup file, you can tell what type of 

balancing parameters are stored in it. The corresponding balancing 

types for different extension names are: 

 

▪ .bals1 – Single plane balancing 

▪ .bals2 – Two plane balancing 

▪ .bals3 – Three plane balancing 

▪ .bals4 – Four plane balancing 

▪ .balso – Overhung balancing 

▪ .balst: – 3 balancer balancing 
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Figure 88 Different extension setup files – example  

Tap the Type dropdown menu to choose the balancing job type. 

After selecting the type of balancing job, you can load a setup file. Only files 

of the same type will be displayed. For example, selecting Single plane 

balancing will show only .bals1 files. 

 

• Tools – From this menu two options are available: 

 

o ICP Bias Check – Check the power and the bias voltage of your ICP 

sensors’ circuit loop.  
Select ICP Bias Check and new window will open with request to 

connect all you ICP sensors to the input sensor. 

Select Verify to perform the check, and the system will show the 

results in a window. The following conditions may appear: 

 

▪ Short circuit (low bias) – Indicates a bad cable with short 

loop. 

▪ Normal (normal bias) – The ICP circuit is working properly. 

▪ Open circuit (high bias) – If no sensor is connected to this 

channel, the bias check shows Open. If an ICP sensor is 

connected to this channel, an open circuit usually means a 

broken cable. 
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 Figure 89 ICP Bias Check – example 

o ICP Power Check – Check the ICP power supply of your Microlog 

dBX. To perform a check, disconnect all sensors and select Start. In 

normal conditions, the power supply of all channels should be around 

25.6 V.  

If the result shows abnormal voltage levels, contact SKF’s Technical 

Support Group TSG.   

 

 

 Figure 90 ICP Power Check – example 

• Version information –Tap the information icon  at the top right corner to 

display the version information. 

 

 Figure 91 Version information – example 

http://www.skf.com/cm/tsg
http://www.skf.com/cm/tsg
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4.3 Balancing setup 
 

After selecting a balancing job (single plane, dual planes, etc.) from the main screen, 

in the newly open view, various parameters for each type of balancing setup are 

shown. 

 

  

Figure 92 Single plane setup (left), Dual plane setup (right) – example 

For accurate results, the sensor positions (CH1, CH2, CH3, CH4) on each display 

must be mounted on the machine as shown in the figure. Placing the sensor in the 

wrong position will generate incorrect balancing coefficients and be potentially 

dangerous.   

 

• Load Default – Load the default saved setup. For more information, see 

section Sensor setup. 

 

• Load setup – Opens the setup dialog where previously saved setups are 

stored. Select one setup from the list and tap Open to load the setup.  

For more information, see section Sensor setup. 

 

• Number of measurement Points – When using a single Point for balancing, 

the measurement will rely entirely on only one sensor on each balancing 

plane to generate the balancing coefficients. 

 

In most cases, this is adequate to balance rotors. However, it may be 

necessary to use multiple Point balancing for more accurate balancing 

results. multiple Point balancing will be performed automatically once the 

user selects more than the minimum number of measurement Points for a 

given plane.  

 

For example, if you select 2 Points in single plane balancing or 4 Points in a 

dual or overhung rotor, you will use multiple Point balancing mode. 

 

• Multiple Point balancing mode – When you select more than the minimum 

Points to balance, the balance algorithm will minimise all the vibration 

measured with the least square approach. This means that when both 
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horizontal and vertical directions are measured in single plane balancing, it 

will try to minimise the vibration levels in both directions. 

 

• Speed – Select a speed range for your balancing task. The default  

12–60 000 RPM is appropriate for most balancing tasks.  

 

• Auto Advance – Allows you to select Off or On start during the balancing 

measurement process. When On is selected, it will automatically enter the 

next measurement step.  

If Off is selected, press Next or OK navigation key to advance to the next 

balancing step. 

• Coast down 1X – This function is for plotting the 1X (first order) vibration 

signal during coast down on your rotating machine. This plotted information is 

very useful in understanding your machine’s behaviour during different 
operating RPMs. For more information, see section Heavy spot estimation. 

  

During your balancing process, you are balancing at a static RPM. With 

Coast down selected in the ON position, it will automatically enter the coast 

down measurement procedure once decreasing rotation speed is detected 

and show the results on the polar plots.  

 

Use this function to view the heavy spot (1X) on the polar plot. 

  

 

 Figure 93 Heavy spot estimation – example 

With the polar plots of the coast down procedure, you can easily find out the 

location of heavy spots even before the trial weight is applied.  

 

• Resolution – Set the resolution of the tracking filters as  

o Low  

o Normal  

o High  
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o 0.03 Order  

o 0.015 Order  

o 0.008 Order  

o 0.004 Order 

Usually, you can set the resolution as Low or Normal. If the vibration signal 

is affected by other signals close to the balancing speed, you may use higher 

resolution to separate the 1X vibration from other signals.    
 

• Average Times – Select between 2, 4, 10, 20 times or manual stop. 

4.4 Tolerance setup 
 

Select Tolerance from the home screen to open the tolerance setup window. 

 

Figure 94 Tolerance setup 

• ISO 21940-11 Grade – From the dropdown menu select one of the grades 

available. When you select Applied To Tolerance, it will apply values as 

shown in the table below. According to ISO 21940-11, the balance quality of 

a rotor is graded from G0.4 (best) to G4000 (poorest) or user defined. 
 

 Table 1 Balance grades available 

G0.4 G100 

G1 G250 

G2.5 G630 

G6.3 G1600 

G16 G4000 

G40 User Defined  
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The balance grade is a calculation of the rotor’s maximum operational speed 
and the rotor’s eccentricity, where eccentricity can be derived from the total 

rotor weight, the radius for balancing and the residual imbalance mass. 

When user defined is selected, you can only change the value for Tolerance 

for P1. The other fields are not selectable when user defined is selected.  

 

 

 Figure 95 Tolerance setup – Grade 

• Grade – Select the balance level grade based on ISO 21940-11 standard. 

 

• Rotor Mass(kg) – Enter the weight of the rotor. 

 

• Max Speed (RPM) – Enter the maximum speed of the rotor. This value is 

used for calculating the maximum allowable unbalance according to  

ISO 21940-11 standard. 

 

Residual Unbalance – allowable unbalance value remaining after the 

balancing job is completed as defined in the ISO 21940-11 standard. 

 

• Radius (mm) – Enter the radius of Plane 1. 

 

• Tolerance – Apply the ISO 21940-11 balance level to know whether the 

residual amount is within the standard. 

 

After the setting is completed, tap Applied To Tolerance. Tap Back to return to the 

previous screen or tap Reset Data key without making any changes. 
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4.5 Phase correction  
 

 In this view the rotational direction and locations of the sensors are set. 

4.5.1 When coast down 1X is disabled 

 

When the coast down 1X measurement is disabled, the input of sensor locations is 

not needed and is disabled as shown below. 

 

 

Figure 96 Phase correction view – coast down 1X disabled 

In this scenario, you need to select the rotation direction to define the direction of the 

compensation angle. When the rotor rotates clockwise, the compensation angle is 

counterclockwise. When the rotor rotates counterclockwise, the compensation angle 

is clockwise. 

The rotation direction and the sensing angle are related to the compensation angle 

calculated by the dynamic balance. Please select the correct rotation direction. 

 

  

Figure 97 Clockwise (left), Counterclockwise (right)  
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4.5.2 When coast down 1X measurement is enabled 

 

If you enabled 1X coast down measurement in the previous step, you’ll need to input 
the sensor locations for measuring the “absolute physical phase” of the vibration 
signals correctly. 

With the absolute physical phase, you can estimate the location of the heavy spot 

even before the trial weight measurement is taken.  

 

The following plot shows an example of sensor locations:  

 

• Tacho at 0 degrees, 

• Ch1 at 45 degrees, 

• Ch2 at 315 degrees with the rotation in a clockwise direction. 

 

 

Figure 98 Phase correction view – coast down 1X enabled 
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4.6 Sensor setup  
 

Use this view to configure the vibration sensor(s) being used for balancing. 

 

 

Figure 99 Sensor setup – example 

• Sensor Type – From the dropdown, select Acceleration, Velocity or 

Displacement. 

 

• Sensor Unit (EU) – From the dropdown, select g, m/s2, in/s2 when 

Acceleration is selected, m/s, in/s when Velocity is selected 

and m, um, mil or inch when Displacement is selected. 

 

Note: Follow the sensor specification sheet for unit setting, do not choose the 

unit randomly. When mV/g is indicated on the specification sheet, select g. 

 

• Display Unit (DU) – select mg, mm/s2, mm/s, um, in/s2, in/s or mil. The 

vibration levels will be displayed in the Display Unit on the vibration 

measurement page. 

 

Note: In this view, the display unit can be selected according to what the user 

wants to view. After the balancing process has started, the display unit 

cannot be changed again. 

 

• Detection – Select RMS, Peak, or Pk-Pk. 

 

• Coupling – Select sensor type ICP, AC, or DC. 

 Note: Refers to the power supply method of the sensor. If using Microlog 

dBX power supply, select ICP. If using an external power supply, select AC or 

DC according to the sensor specification. 
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• Sensitivity mV/ SU – An input box for the user to enter the correct sensitivity 

for the sensor used. In the example above, it is 100 mV/ g. 

 

• Apply to all – Use this function to apply the same sensor sensitivity values. 

For example: the sensitivity of Ch1 is 100. When you tap Apply To All, the 

sensitivity of Ch2 to Ch4 will be changed to 100. 

 

• Save to Default – Save the settings as default values. 

 

• Save Setup – Opens the Save Dialog view. Enter Name and tap Save to 

save the setup. 

 

Figure 100 Save dialog – example 

o Edit – select a setup and tap the Edit menu button. From this 

menu you can Cut, Copy, Paste, Delete, or Rename a 

setup, or create a new folder.  

Tab Back to return to the sensor setup view. 
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4.7  Vibration measurements 
 

Select Next from the sensor setup page and the following view will appear. In the 

lower left part of the window, you will see the help text:  

 

Start rotor. Press “Start” to read data 

 

 

Figure 101 Initial run measurement – example 

Tap Start to start the initial measurement. 

 

Balancing a rotor is an interactive measurement process. Follow these steps and 

read the help text at the bottom of each screen to guide you through the process. 

 

The rotation speed is now displayed. In the example below it is 3560 RPM. 

At the bottom of the screen, the help text says:  

Reading rotation speed, press “OK” to accept.  
 

Navigate using the navigation keys and tap OK. 
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Figure 102 Rotation Speed – example 

After you tap OK, notice that the amplitude, phase, and overall readings are 

displayed, and the 1X vibration data is shown in the polar plots.  

 

 

Figure 103 Initial Run measurement in progress - example 

 

Tap Next to continue or Redo to repeat the test. 
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4.8 Manual entry 
 

A Manual Entry option is available under the Tools menu for manual balancing data 

entry, allowing you to review and change balancing run data. Once selected, you can 

manually enter the rotation speed, vibration magnitude/overall, and phase angle for 

the balancing runs by selecting the entry. 

 

Figure 104 Vibration measurement Manual Entry 

4.9 Heavy spot estimation 
 

If 1X coast down option is selected from the balancing setup menu, it will start to 

automatically make measurements of 1X and plot as the rotor will start decreasing its 

speed. The vibration level and phase of the 1X traces are shown under resonance, 

close to the 1st resonance and over resonance examples. 

 

Identifying the heavy spot estimation after the 1X coast down is easy. Although you 

may derive the heavy spot after the trial weight measurements, the user can also use 

the 1X coast down to reduce the vibration levels with the trial weights. This technique 

prevents the user from potential danger by putting the trial weight in the wrong place, 

which could create excessive vibration, but the main point is to use the information to 

reduce the balancing time.  

 

According to the physical rules, the 1X vibration displacement is in the same phase 

as the centrifugal force when the rotor is rotating at a speed which is lower than the 

1st resonance of the structure, and the location of the centrifugal force is the same as 

the location of the heavy spot.  

To show the location of the heavy spot, the coast down 1X measurement will always 

measure the vibration signal in the displacement unit.   
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4.9.1 Balancing with resonance 

 

Sometimes a balancing job is performed at speed close to the resonance frequency.  

In such cases, the balancing coefficients may lead to poor balancing results because 

the vibration phase becomes unstable at or close to the resonance frequency. 

The 1X polar plot is useful to identify resonance at or near the balancing RPM. It is 

recommended in this situation to use the 1X heavy spot from the polar plot as it 

would be more reliable in this situation. 

 

Under resonance example 

For a machine whose rotational speed is below the resonance, the 1X coast down 

trace would look like a straight line like in the example below. That means it has a 

constant phase during the coast down process.  In this case, the constant phase is 

exactly the location of the heavy spot. 

 

1. Operation speed 

 

Close to the 1st resonance example 

When rotational speed is close to the 1st resonance of the structure, the 1X coast 

down trace will look like a curve, as illustrated in the figure below. As the machine 

coasts down to a lower speed, the phase becomes constant again. This constant 

phase at low speed indicates the location of the heavy spot. 

1. Operation speed 

 

Above the 1st resonance example 

When rotational speed is higher than the 1st resonance of the structure, the 1X coast 

down trace would look like a curve with some circles, as illustrated in the figure 

 1

 1
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below. As the machine coasts down to a lower speed, the phase becomes constant 

again. This constant phase at low speed indicates the location of the heavy spot. 

 

1. Operational speed 

4.9.2 Trial weight 

 

Trial weights are necessary for the balancing process to balance your rotor. You can 

choose to add or subtract (cut) weight on the plane. If you are adding weight, you are 

physically attaching a weight to the rotor.  

 

If you are removing weight, you are physically removing the weight (or material) from 

a rotor. This could be removing a set screw or by drilling a hole. 

 

 

Figure 105 Trial weight on Plane 1  

• Method – Select Add or Cut. 

• After – Select Remove or Remain trial weight. 

• Trial Mass – Tap the field and enter the trial weight.  

 1
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To derive accurate balancing coefficients, select a trial weight which can 

make the vibration levels or phase(s) change effectively.   

 

If you don’t know how much trial mass needs to be added, select  
Tools > Estimate trial weight to make an estimation. 

 

 

 

• Position – Select or enter the trial weight degree. There are two options to 

enter the position value, manually and by selecting a component. 

 

o Manual input – Tab the position field and enter the value. In the 

example below, the trial weight is set to 15 degrees, and the result is 

shown in the polar plot to right.  

 

  

• Figure 106 Trial weight – manual input   

o Selecting a component - When the balancing weights are placed in 

fixed components, move the polar plot cursor to set the trial weight 

position. In the following example, component 2 of the 12 

components selected, and the trial weight position is set as 30 

degrees automatically. 
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Figure 107 Trial weight with component 1 of the 12 components selected 

• Number of components - Tap the field and enter the number of 

components. 

4.9.3 Multiple Point balancing and projected vibration 

 

When the number of measurement Points is larger than the number of balancing 

planes, multiple Point balancing is enabled. It will derive more than one set of 

balancing coefficients and may lead to different balancing mass instructions.  

However, when multiple Point balancing is enabled, the software will conduct a “least 
square” optimisation and minimise the sum of the square of vibration levels at 
different Points or directions. With this technique, it can ensure that all the measured 

vibration levels are reduced to the best possible conditions.  

 

Example: 

Suppose we select two Points for a single plane balancing job. The 1st vibration 

sensor is located at the vertical direction of bearing one (defined as Point one (CH1), 

and the 2nd sensor is located at the horizontal direction of the same bearing (defined 

as Point 2 (CH2). 

 

 Figure 108 Multiple Point balancing – example 
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After the initial vibration and trial weight vibration measurements, the Balancing 

module then derives two balancing coefficients. One balancing coefficient from Point 

one and the other balancing coefficient from Point two. 

 

Case A – Balancing with coefficient from Point one 

If we balance the rotor by using coefficient from Point one, we expect to reduce the 

vibration of Point one from A to A1 (as shown in the plot below), which indicates the 

perfectly balanced condition.  

In this case, the vibration of Point two based on the balance coefficient one is 

projected to change from B to B1, which shows an unsatisfactory improvement. 

These expected changes of vibration vectors are called projected vibration, and 

they are displayed in the following plots. 

 

 

Figure 109 Case A – Project vibration for Point one (left)  
Case A – Project vibration for Point two (right)  

 

Case B – Balancing with coefficient from Point two 

If we balance the rotor using coefficient from Point two (still using one coefficient), 

(using the standard balancing algorithms), we expect to reduce the vibration of Point 

two from B to B2, which indicates perfectly balanced. But in this case, the vibration at 

Point one changes from Point A to A2, which is not satisfactory. The projected 

vibration for this case is shown in the Case B Plot. 

 

 Figure 110 Case B – Balancing with coefficient from Point two 
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Case C – Balancing with least squares calculation 

The method of least squares means that the overall solution minimises the sum of 

the squares of the errors made in the results of every single equation. Essentially the 

Least squares calculation is a method in balancing to reduce the larger 

vibration more quickly than the smaller vibration signals. 

 

By conducting least squares calculations with both the balancing coefficients from 

Point one and Point two, we derive optimum balancing conditions as illustrated by the 

following projected vibration plots Case C and Case D. Note that both the vibration at 

Point one and Point two are reduced significantly at the same time.  

In our Balancing module (multiple Point), least squares calculation is always used. 

The display will show the balancing information from least squares calculation.  

 

 Figure 111 Case C – Projected vibration for Point one (left) 
Case C – Projected vibration for Point two (right) 

Case D – Balancing with least squares calculation with weighting 

Adding a larger weighting factor to balancing reduces the vibration more at one Point. 

(Likewise, adding a smaller weighting will reduce the vibration less.) 

 

What does weighting do?  

Weighting involves emphasizing the contribution of some aspects of a phenomenon 

(or of a set of data) to a final effect or result, giving them more weight in the analysis. 

Rather than each variable contributing equally to the result some data are adjusted to 

contribute more than others.  

 

Note: Weighting factors are numbered from 0 – 1. 

 

For example, in Case C, suppose that you are not satisfied with the result and want 

to reduce the vibration more at Point one than at Point two.  

With weighting you can apply a larger weighting factor to reduce the vibration more 

and achieve the desired effect.  

In this example, factor 1 is applied to the vibration of Point one, and factor 0.5 is 

applied to the vibration of Point two.  

Compared with Case C, the projected vibration of Point one is reduced more, as you 

can see from the following plot. 
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In practice, using the LSC calculation with weighting, adding a higher number will, in 

effect, reduce the vibration signal more. 

 

 Figure 112 Case D – Projected vibration for Point one, with 1.0 weighting applied (left) 
Case D – Projected vibration for Point two, with 0.5 weighting applied (right) 

  

 
Weighting 

applied to Point 1 

Weighting 

applied to Point 2 

Least 

squares 

calculation 

Multiple 

Point 

balancing 

Case A Not applicable Not applicable No No 

Case B Not applicable Not applicable No No 

Case C 1 1 Yes Yes 

Case D 1 0.5 Yes Yes 
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4.9.4 Correction weight 

 

After the vibration measurements with trial weight(s), the location and amount of the 

balancing mass required to balance the rotor are shown. This is called the correction 

weight. When the multiple Point balancing is not enabled, a single correction weight 

is calculated. 

 

Balancing mass of single Point balancing 

When the single Point balancing is selected, the balancing instructions are as below. 

 

 

Figure 113 Correction weight – single Point 

• Mass – The amount of balancing weight. 

 

• Phase – The location of the balancing weight. 

 

• Residual imbalance – The ratio of the corrected unbalanced mass to the 

first unbalanced mass. The first time Residual imbalance is 100%.  

 

For example: The first time, the unbalanced mass is calculated to be 100 

grams. If the unbalanced amount is reduced to 50 grams after compensation, 

the Residual imbalance will display 50%. The smaller the percentage value 

is, the better the dynamic balance is. In other words, when the percentage 

rises, the compensation quality or direction is incorrect. 
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Balancing mass of multiple Point balancing 

When the multiple Point balancing is enabled, the balancing instructions are as 

below. 

 

 

Figure 114 Correction weight – multiple Point 

Note that white circle in the polar plot shows the range of the balancing tolerance. 

For more information see section Tolerance setup. 

 

• Projected Vibration – Click to show the expected 1X vibration of different 

measurement Points before and after the balancing mass is applied.   

 

 

Figure 115 Correction weight – Projected Vibration – example  
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• Edit – Select to edit the balancing mass and phase. 

 

 

Figure 116 Correction weight 1 edit – example  

After editing the balancing mass, from this view you can enter the Projected 

Vibration to see how the 1X vibration may change with the new balancing mass. 

 

• Restore – Restore the balancing mass to the original values. 

 

• Weighting – Add custom weighting number(s) to different measurements 

and recalculate the balancing results. For more information see section 

Multiple Point balancing and projected vibration. 
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• Tools – Tap to open the Tools menu. 

  

 

Figure 117 Balancing Mass – Tools 

o Add/Cut P1 – Changes the balance correction (plus/minus) method 

for plane 1. 

 

o Tolerance – Apply the ISO 21940 balance level. See section Home 

screen. 

 

o Unequal radii – Calculate the compensation mass when the test 

weight radius is different from the correction radius. 

 

o Drill depth – Calculate corrected (minus mass) drilling depth. 

 

o Component – Can calculate the mass required to increase or 

decrease in balance holes at different positions. 

 

o Show text only – Toggles between polar and displaying mass and 

phase values, in large text format. 

 

o Vibration History – View vibration measurements throughout the 

balancing process. 

 

o Balance History – View corrected mass values throughout the 

balancing process. 

 

Description of timing and operating procedures of each tool 

 

• Add/Cut P1– According to the rotor balance correction method, change the 

balance correction method at any time from adding mass to minus mass; 
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from minus mass to adding mass, the balance angle also changes 

accordingly. 

 

Figure 118 Correction weight – example  

• Tolerance – For more information, see section Tolerance setup. If the 

balancing tolerance is set, the range of tolerance will be shown with a white 

circle in the middle of the radar plot, with which you can tell whether the 

residual imbalance meets the selected ISO standard or not. Use Zoom in or 

Zoom out keys to adjust the radar display when needed. 

 

• Unequal radii – When the trial weight radius is different from the correction 

radius, this function must be used to correct the correctness of the 

unbalanced mass. 

 

Figure 119 Unequal radii view – example 
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Tap the respective column in the table, and using lowercase on your keyboard, input 

the correct diameter of trial weight (Diameter(mm)) and Diameter of balancing 

weight (Balancing). 

 

Tap Applied To Calculation, and the residual amount will be recalculated according 

to the changed size. 

 

• Drill depth – When the balance correction method is to remove the mass, 

use this function to calculate the drilling depth according to the material and 

the diameter of the drill. 

 

 

Figure 120 Drill depth view – example 

After selecting the material and entering the drill diameter, the system will calculate 

the drilling depth and the drilling phase.  

 

Note: There are currently three materials: iron, copper, and aluminium. 

 

Tap Back to return to the previous screen. 

 

• Component – If a counterweight hole has been reserved on the calibration 

plane, use this function to calculate the balance mass required to increase or 

decrease at the position of the counterweight hole.  
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Figure 121 Component weight – example 

1. Location of the balancing 

weight  

2. Locations of the selected 

balancing components 

 

Input the total number of counterweight holes and the software will automatically 

calculate the position and mass of the counterweight holes. If the position of the 

counterweight hole cannot add or subtract the unbalance mass, you can use the 

manual mode to modify the position of the counterweight holes. 

 

Tap Manual and tap the Component table box. Input the hole position and tap 

Enter. The mass of the hole is now updated.  

 

Note: When selecting the balancing components manually, always make the 

balancing weight (white line on the radar plot) between the positions of the 

components. 

 

Tap Back to return to the previous screen. 

 

• Show text only – The radar chart can be turned off and corrected mass and 

angle displayed in a larger font. 

 

Figure 122 Correction weight – Large font example 

1 

2 
2 
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• Vibration History and Balancing History – During the correction process, 

all vibration and balance measurements are recorded. Therefore, the entire 

balance and vibration history can be viewed at any time. 

Switch between vibration and balancing history view using the ◄ and ► 

buttons on the left and right below the radar graph. 

 

Note: When the Data ID begins with V, it represents vibration data, and when 

it begins with M, it represents balancing data. 

 

 

Figure 123 Vibration History view –example 

 

Figure 124 Balancing History view – example 
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• Back – Return to the original polar plot screen displaying residual quantity. 

 

• Redo – Return to previous vibration (balance) history. 

 

• Coast Down 1X – Switch the speed down state 1X polar plot. If the data is 

not available, it will be displayed in white. 

 

• Hide/Show – Toggle to show or hide single-stroke vibration (balance) history. 

 

• Show Trial – Display the trial run for comparison. 

 

• Redo – Remeasure the vibration of a specific amount of data from the 

Vibration history. Only at V0, Vt can be used. If it is selected, a window will 

pop-up to confirm whether to redo the data. If it is confirmed to be redone, the 

measurement process will be started from the data. 

 

 

 

Sometimes, the balancing coefficients are derived from very high initial 

vibration and are very nonlinear, which would cause inaccurate balancing 

results.  Selecting a correction weight data with a smaller vibration level to 

renew the factors can improve the accuracy of balancing results.  

 

• Renew Factor – Select from Balancing History to recalculate the balancing 

coefficients. Sometimes, the balancing coefficients are derived from very high 

initial vibration and are very nonlinear, which would cause the balancing 

results not accurate. Selecting a correction weight data with a smaller 

vibration level to renew the factors can improve the accuracy of balancing 

results. 
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Figure 125 Renew factors – example 

• Generate report – Tap to enter the Generate report view where you can 

enter the general information for the report. 

 

 

Figure 126 Generate report – example  

o Report Header Image (160×40) – Tap Select Header Image and 

select an image. The image will be shown in the top left corner of the 

report as a company logo. Recommended image size is 160×40px. 
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o Customer Name – Tap and enter the customer’s name. 
 

o Rotor type – Tap and enter the rotor type. 

 

o Rotor Serial Number – Tap and enter the serial number of the rotor. 

 

o Test Date – Tap to select the test date. 

 

o PDF Generate Report – Tap to generate report as PDF.  

 

 

Figure 127 Generated PDF report – example  

o Save Report – Review the report and tap Save Report to save the 

file. By default, the file is saved to D:\dBX\MicrologdBX\Launcher\. 

After saving, you can open the file from the dBX Documents 

application on the home screen.  

 

To save the file to an external USB disk, tap Save report and select 

the external disk to save the report. 

4.9.5 Overhung balancing 

 

Due to the high level of couple effects, balancing an overhung rotor with standard 

single-plane or two-plane techniques is often challenging. This module implements 

an alternative technique to enhance the balancing of overhung rotors. This balancing 

algorithm treats the imbalance weights as static imbalance and couple imbalance, 

respectively. 

You’ll find that balancing an overhung rotor is almost the same as balancing a 
standard two-plane rotor, with the main difference being the method of applying trial 

weights. 
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Plane names and sensor locations 

After selecting overhung balancing, follow the illustration plot to set up your sensor 

connections. Note that Plane 1 is the inboard plane, close to the bearing, while Plane 

2 is at the other end. You can also select 4-point balancing to reduce vibrations at 

other points simultaneously. 

 

 

Figure 128 2-points overhung balancing – example 

 

Figure 129 4-points overhung balancing – example 

Adding trial weight to Plane 1 

After the initial vibration measurement, the program will prompt you to add a trial 

weight to Plane 1. In the illustration, a 1 gram trial mass is added at 0 degree and will 

be removed after the vibration measurement. Note that Plane 1 is the inboard plane, 

as previously described. 
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Figure 130 Trial weight on Plane 1 – example 

Adding a couple trial weight to the rotor 

After measuring the vibration with the trial weight on Plane 1, the software will guide 

you to add a couple trial weight to the rotor. A couple consists of a pair of equal-

weight masses placed on Plane 1 and Plane 2, respectively, 180 degrees apart. 

 

Correction for unequal diameters 

Before setting up the couple trial weight, a window will prompt you to select Equal or 

Unequal for the diameters of Plane 1 and Plane 2. If Equal is selected, tap Next to 

proceed to the next view. 

 

Figure 131 Overhung Trial Diameter Setup Equal – example 
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If Unequal is selected, enter the diameters of both planes before proceeding to the 

next view. This information will be used to accurately calculate the couple effect. 

 

 

Figure 132 Overhung Trial Diameter Setup Unequal – example 

 

Couple trial weight setup 

The following view shows the proper way to add the trial weight to Plane 1 and  

Plane 2. 

 

Figure 133 Add a couple of trial weight – example 
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In this example, the trial weight on Plane 1 was set as After -> Remove, hence it can 

remain on plane 1 since it is removed and then added back to Plane 1 as a portion of 

the couple. Therefore, only the trial weight on Plane 2 needs to be added to create a 

couple trial weight. 

 

In the P2 section of the view, the trial weight on Plane 2 is shown. It has the same 

mass as the trial weight on Plane 1 and is positioned 180 degrees apart. 

 

You can manually adjust the position and amount of the trial weight on Plane 2. This 

will automatically update the settings for Plane 1 as well. 

 

After adding the couple trial weight to the rotor and taking vibration measurements 

again, the software will guide you on how to add balancing weights to Plane 1 and 

Plane 2 to balance the rotor. Repeat this process until the desired balancing quality is 

achieved. 

4.10  Three balancer balancing 
 

From the home screen, select 3 balancers to initiate the procedure for balancing a 

rotor with three permanently installed, equal-weight balancers. This method is 

typically used to balance the grinding wheel of a grinding machine. 

 

The procedure for balancing with 3 balancers is similar to a regular balancing task. It 

includes the initial run, trial weight application, and applying correction weights to the 

rotor. 

 

However, this method differs as it requires adjusting the angular positions of the 3 

balancers to achieve the desired balancing effect on the rotor. 

 

Reset the balancers 

Before starting the balancing process, set the positions of the 3 balancers to 0, 120, 

and 240 degrees. This resets their combined effects to zero, allowing measurements 

of imbalance to be taken exclusively from the rotor itself. 

 

 

Figure 134 3 balancer positions – example 
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Apply a trial weight to the rotor 

After the initial run, the software will prompt you to apply a trial weight to the rotor by 

adjusting the balancer from 0 degrees to 30 degrees. You can also enter a different 

angle to customize the trial weight setting. 

 

 

Figure 135 3 balancer positions – rotor degrees example 

 

Apply correction weight 

After measuring the vibration with the trial weights, the correction weight information 

and the angular positions of the 3 balancers will be calculated and displayed. Adjust 

the three balancers to the specified angular locations and restart the rotor to evaluate 

the balancing effect. 

 

 

Figure 136 Angular location – example 
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Fine tune of the balancers 

After applying the correction weight to the rotor, restart it and take vibration 

measurements to evaluate the balancing effect. The software will then prompt you to 

fine-tune the balancer locations to further improve the balancing quality. For example, 

based on the plot below, the software recommends adjusting the angular positions of 

the 3 balancers by -2.7 degrees, +0.6 degrees, and -6 degrees. Repeat these 

adjustments until the balancing quality meets expectations. 

 

 

Figure 137 Angular location – fine tune example 
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5 Utility module 

5.1 Introduction 

  

The Utility module allows you to review the system information. The displayed 

information includes Product information, Software information, Windows 

information, etc. 

 

 

Figure 138 Utility module view - example 

  

 Before using the software, please read and understand the separate 

Microlog Analyzer dBX Quick Start Guide. 
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5.2 DAQ (Data Acquisition)  
 

Tap to enter data acquisition hardware testing mode. 

 

 

 

• DAQ reset – The reset function is to disconnect and reconnect the DAQ, 

through GPIO (general-purpose input/output). You can perform the DAQ 

reset to restore hardware connection when the Microlog dBX loses 

connection to the DAQ hardware. 

 

 

Figure 139 DAQ reset – example  

 

• DAQ test – Switch to the test page to perform a simple function test. On the 

Test page, you can set the bandwidth, the number of analysis channels, 

voltage coupling and input range. This page provides viewing time 

waveforms. 

The test function is a useful tool to verify whether your hardware is working 

properly.   

You can set the bandwidth, select measurement channels, coupling mode 

and input range to conduct measurements. 



UTILITY MODULE 

DAQ (Data Acquisition) 

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

135 (235) 

 

 

 

Figure 140 DAQ test – example  

Tap Start to proceed with data acquisition. 

 

 

Figure 141 Acquisition proceeds – example  

 

Tap Stop to stop the data acquisition. 
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5.3 Configuration menu  
 

 

Figure 142 Configuration view – example  

• Date / Time – Select time zone from the dropdown menu. Tap Change time 

and in the pop-up, window set the date and time. Tap OK to save the change. 

 

  

Figure 143 Change date and time – example  

Tap Default to restore to the default settings.  

 

• Language – Select a language from the dropdown menu.  

The selected language will be applied to all modules.  
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• Password verification – Manage password settings.  
 

o Enable / Disable – If you uncheck the Enable option, a pop-up 
window will ask you to confirm this action. Select Yes to disable the 
startup password or Cancel to exit. 
 

 

 

• Change password – Select to change the saved password. A pop-up 

window will ask you to restart the device and set a new password. To change 

the password:  

 

1. Tap OK. 

 

 

 

2. Tap the Password field, enter the old password and press OK. The device 

will restart. 

 

 

 

3. Tap the Set password field to display the keypad and enter the password.  
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4. Re-enter the password in the Verification field.  

 

 

• Auto logout – Select an auto-logout time. 

To disable the auto logout function, select No timeout. 

To set an auto logout time, select 5 minutes or 15 minutes. 

  

 

 

• Screen brightness – Use the slider to adjust the screen brightness. 

 

• Calibration reminder – Set the time for calibration reminder. To ensure your 

device functions properly and performs accurate measurements, we 

recommend calibrating it at least once every two years. 

Select 12 or 24 months calibration period reminder. Select Off to turn off the 

reminder. 
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When there are 30 days remaining until the set calibration date, the system 

will start displaying reminders about the time left until the calibration due date 

in the bottom-right corner of the home screen. 

 

 

Figure 144 Calibration reminder message – example  

To postpone the calibration date, tap on the reminder message and from the 

pop-up window select OK. Tap Cancel to exit the dialog without postponing 

the date. 
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5.4 Tools menu 
 

 

 

• Program list – View the software modules, their released version and 

authorization status. 

 

Figure 145 Program list view – example  

o Update software – To perform a software update:  

 

1. Tap Update software and from the dropdown select a disk (external USB 

device) containing the update file. 

 

 

2. Select an installation file. Note that the installation file has .exe extension. 
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3.  Tap OK to run the installation file. 
 

 
 

4. In the pop-up window you can follow the installation process. Tap Cancel to 

cancel the installation. 
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o Software licence – To install software module authorisation: This is 

mainly for upgrading from the M-Pack to the F-Pack features. Contact 

SKF’s Technical Support Group TSG  for upgrade purchase. 

 

1. Tap Software license and from the dropdown select a disk (external USB 

device) containing the update file. 

 

 

 

2. Select the license file from an external USB device.  
Note that a licence file has .auh extension. 
 

 
 

3. Tap OK to run the installation file. 

 

4. In the pop-up window you can follow the installation process. Tap Cancel to 

cancel the installation. 

   

http://www.skf.com/cm/tsg
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• Update firmware  

 

1. Tap Update firmware and from the dropdown select a disk (external USB 

device) containing the update file. 

 

 

2. In the pop-up window you can follow the update process. 
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• Update FPGA (Field-programmable gate array) 

 

1. Tap Update FPGA and from the dropdown select a disk (external USB 

device) containing the update file. 

 

2. In the pop-up window you can follow the update process.  

 

 

 

Tap Exit to exit the Utility software. 
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6  dBX Analyzer module 

6.1  Introduction 

 

The Analyzer module is used for performing real-time measurements with FFT and 

Order Tracking, save the raw data as recorder files and playback them as real-time 

analysis.  

It also supports multiple analysis modes, allowing you to run different analysis 

modules simultaneously, such as FFT, Order Tracking and Recorder.  

 

Optional modules: Separate licenses are available for Raw data recorder and 

Order Tracking for running advanced real-time measurements and raw data 

recording. 

 

To start the Analyzer module, using the navigation keys, navigate to the SKF 

Analyzer icon and press OK or double tap the icon. 

 

 

Figure 146 Home screen – dBX Analyzer icon 

 

 Before using the software, please read and understand the separate 

Microlog Analyzer dBX Quick Start Guide. 
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6.2  Analyzer instrument modes 
 

Analyzer can work in selected instrument mode: 

 

• Real time analysis – Measure signal and perform real-time analysis with 

FFT or Order Tracking features. 

 

• Raw Data Recording – Save the raw signal to the hard drive with a simple 

spectrum and waveform display. 

 

• Playback Analysis – Analyzer supports raw data playback of a saved file. 

Once your raw data file is saved, Analyzer can replay the data file as a live 

measurement. An event can be recreated as if you were on-site and perform 

a playback analysis of the data file. 

 

• Real-time Analysis with raw data recording – Combines Real-time 

Analysis and Raw Data Recording modes. While you perform Real-Time 

analysis, Analyzer allows you to throughput the raw data into the hard disk for 

a backup of important data. 

 

• Data review – With the Data review mode you can:  

 

o Add data files for data viewing, analysis, and playback. 

o Work with multiple channels on a single graph, or separate if needed. 

o Perform post-analysis by applying mathematical processing. FFT, 

IFT, integration, differentiation, weighting functions, and filters. 

o Work with multiple cursor types: Single, Dual, Sideband, Harmonic, 

Move peak and multiple single cursors. 

o Export data files to XML, UFF or Wav file formats. 

6.3  Analysis modules 

6.3.1  FFT module  

 

• Functions for FFT analysis: Time waveform, Auto spectrum, Complex 

spectrum, Cross spectrum, FRF, Coherence, Power cepstrum, Power 

spectral density, Envelope spectrum, Envelope waveform, Overall level, 

Mean trend, Rate trend and Rotation speed. 

 

• Trigger for FFT analysis – Trigger source, trigger slope, trigger level, trigger 

delay and peak trigger. 

 



DBX ANALYZER MODULE 

Analysis modules 

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

147 (235) 

 

 

• Band & resolution for FFT analysis – Select from 50 Hz to 40 kHz 

frequency band and 50 to 51 200 lines of resolution with real-time zoom FFT.  

 

• Average for FFT analysis – Spectral or time domain average; linear, 

exponential average or peak hold; overlap percentage: 0%, 25%, 50%, 75% 

or max.; average number: from 1 to 5 000 times selectable; overload rejection 

and a preview of a waveform.  

 

• Signal map for FFT analysis – Map functions: Time waveform, Auto power 

spectrum, Complex spectrum, and Cross spectrum. Measurement controls: 

Free run, armed by time step or armed by RPM step.  

When the signal map is enabled, you can display it as a waterfall or intensity 

plot from the Live data panel. 

6.3.2  Order tracking module 

 

• Functions for Order Tracking analysis – Order trace, Order spectrum, 

Spectral map, Orbit, Filtered orbit, Orbit and waveform, Shaft centerline, DC 

gap and RPM profile.   

 

• Order resolution – 1/2 order, 1/4 order, 1/8 order or 1/16 order. 

• Max order – 5, 10, 20, 50, 100, 200, 400, or 800. 

• Rotation speed – 30 to 240 000 rpm. 

• Types of average – Off, linear, exponential, and peak hold. 

• Overlap level – 0%, 25%, 50%, 75% and max. 

• Trigger method for tachometer channel – Time waveform or spectrum. 

• Measurement control – Time step, RPM step (run up, coast down or up and 

down) or both. 

6.3.3  Raw data recorder module 

 

• Display – Display Block waveform, raw waveform, and power spectrum 

during data recording in Raw data recorder mode.  Display real-time analysis 

functions and raw waveform in Real-Time + Recorder mode. 

 

• Recording modes – Record raw data in Raw data recorder mode or 

perform real-time measurement and record raw data at the same time in Real 

Time + Recorder mode. 

 

• Playback analysis – Replay the raw data and conduct FFT or Order 

Tracking analysis. 
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6.4  Navigation and functionality 
 

 

Figure 147 Analyzer Home screen with first use of the module 

You can customize the display to show various toolbars, projects, files, charts, and 

status. 

 

 

Figure 148 Analyzer Home screen – general layout 

1. Menu buttons 

2. Data panel 

3. Toolbar 

4. Plot area 

5. Status bar 

 5

 4

 3

 2

 1
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• Menu buttons – Tap on each menu or use the menu key to open the menu 

options. Each menu function is described in detail in this manual.  

 

• Toolbars are a convenient way to create a shortcut for your file 

management, measurement, or display setup.   

6.5  How to perform a measurement 
 

1. Select a mode from the Mode menu. For example, if you are conducting a real-

time analysis, select Real Time Analysis. 

 

 

 

2. From the Configuration menu, select Analyzer Setup set up Analyzer, 

Channel, Engineering Unit, FFT, or Order Tracking measurement parameters. 

 

 
 

3. To arrange the display layout, select a function from the Live Data panel and tap 

OK to create a data plot in the plot area. 

 

4. To start / stop a measurement, press the Start / Stop key or the Start / Stop 

buttons on the screen. 

 

5. After the measurement is completed, select File > Save project to save the 

measurement data and the setup parameters to a project file. 
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6.6  Perform test from a pre-set template 
 

From the home screen, you can select a pre-set template to perform a specific test 

with the dBX Analyzer. These pre-set templates are built with the typical parameters 

required to perform specific types of testing. You can also change the settings of a 

template for future applications. 

 

 

Figure 149 Microlog Analyzer Home screen 

6.6.1  Bump test 

 

Double tap the Bump test icon on the home screen to activate dBX Analyzer and 

load the pre-set parameters bump for a single channel bump test. With this template, 

you can perform a Bump test to investigate the resonance of a structure or collect 

necessary test data for a complete modal analysis with a 3rd party software.  

 

Connect an ICP accelerometer to channel 1 and press the Start / Stop key to start 

the measurement. Use a hammer to impact the structure to initiate the measurement 

and display the result. 
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Figure 150 Bump test view – example  

The pre-set parameters for this template are shown in the table below. To change the 

values of the parameters, enter the Setup menu. 

Table 2 Pre-set parameters  

 Ch 1 Ch 2 Ch 3 Ch 4 

Coupling ICP Off Off Off 

Input range 5 V - - - 

Window Uniform - - - 

Node 1 - - - 

Direction +X - - - 

Advance 

number 

0 - - - 

Sensor type Acceleration - - - 

Sensor unit g - - - 

Sensitivity  100 mV/g - - - 

Display unit g - - - 

Filter Off - - - 

 

• Measured functions – Auto Spectrum 

• Frequency – 1000 Hz  

• Resolution – 800 lines 

• Average – Peak hold average, 1 time  

• Trigger – Channel 1, 100 mV trigger level, -3% trigger delay  
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6.6.2  gE Enveloping 

 

Double tap the gE Enveloping icon on the home screen to activate dBX Analyzer 

and load the pre-set parameters for a gE Enveloping test. With this template, you can 

measure the time waveforms and envelope spectrum to investigate the condition of 

bearings. The envelope filter is set as ENV3: 500~10 kHz.  

 

Select Setup to change it when necessary. Connect a uniaxial ICP accelerometer to 

channel 1 and press the Start / Stop key to start the measurement.  

 

Figure 151 gE Envelope view 

The pre-set parameters for this template are shown in the table below. To change the 

values of the parameters, enter the Setup menu. 

Table 3 Pre-set parameters  

 Ch 1 Ch 2 Ch 3 Ch 4 

Coupling ICP - - - 

Input range 5 V - - - 

Window Hanning - - - 

Sensor type Acceleration - - - 

Sensor unit g - - - 

Filter Off - - - 

 

• Measured functions – Time waveform and Envelope Spectrum 

(ENV3 500–10 kHz) 

• Frequency – 1000 Hz  

• Resolution – 1600 lines 
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• Average – Spectral average, 1 time  

• Delay – 1 second 

• Trigger – Off 

6.6.3 FRF & ODS Analysis  

 

Double tap the FRF & ODS analysis (Frequency Response Function and 

Operational Deflection Shape Analysis) icon on the home screen to activate dBX 

Analyzer and load the pre-set parameters for an FRF and ODS test. Connect a 

triaxial ICP accelerometer to channels 1, 2 and 3 and connect the reference 

accelerometer to channel 4.   

 

 

Figure 152 FRF & ODS Analysis view 

 

Figure 153 Channel Setup view: Initial node numbers and directions 
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In the default setting, the channel IDs are set as +1X, +1Y and +1Z and 1X. You can 

edit it when you need to. The pre-set parameters for this template are shown in the 

table below. To change the values of the parameters, enter the Setup menu. 

Table 4 Pre-set parameters  

 Ch 1 Ch 2 Ch 3 Ch 4 

Coupling ICP ICP ICP  ICP 

Input range 5 V 5 V 5 V 5 V 

Window Hanning Hanning Hanning Hanning 

Node 1 1 1 1 

Direction +X +Y +Z +X 

Advance 

number 

0 1 1 1 

Sensor type Acceleration Acceleration Acceleration Acceleration 

Sensor unit g g g G 

Sensitivity  100 mV/g 100 mV/g 100 mV/g 100 mV/g 

Display unit g g g g 

Filter Off Off Off Off 

 

• Measured functions – Time Waveform, Auto Spectrum, Cross spectrum, 

FRF 

• Frequency – 500 Hz  

• Resolution – 800 lines 

• Average – Spectral average, 10 times, overlap 50%  

• Trigger – Off 

 

When the sensors are installed to the correct positions and directions, press the 

Start/Stop button to take the first measurement. After the measurement is 

completed, the software will prompt you to save the data with a file name which 

consists of the point IDs and the date. In this example, the prompt file name is set as 

+1X+1Y+1Z+1X_20231031. Press OK to save the data file or select to save it with 

another file name or to another folder when you need to. 
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Figure 154 Save data – example  

Now, you can move the triaxial accelerometer to the second node. Because the 

advance number of channels 1, 2 and 3 are set to “1”, their node number will 
advance to “2” after the data saving.  
It is recommended to enter the Channel Setup page to check the node number and 

the sensor directions before each measurement.   

 

When necessary, change the node number or direction to match the location and 

orientation of the triaxial accelerometer. 

 

 

Figure 155 Channel Setup view – Initial node numbers and directions 

Press the Start/Stop button to take the second measurement. Then the software will 

prompt you to save the data with a new file name +2X+2Y+2Z+1X_20231031 

 

After the measurements of all Points are completed, exit the Analyzer module, and 

use the Sync Data Collector module to transfer the data files to your computer for 

post-analysis. Note that when a data file is saved in Analyzer format, another file in 

UFF (Universal File Format) is saved simultaneously. The UFF format is supported 

by most 3rd party software for Modal or ODS analysis, and you can use them for the 

ODS analysis. 



DBX ANALYZER MODULE 

Perform test from a pre-set template 

156 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E 

 

 

Figure 156 UFF saved files – example 

How to save the UFF files to a specified holder     

By default, the UFF files are saved to the same folder where the test data files are 

saved. However, you can specify the destination folder for saving the UFF files.  

Select the File > Save Option from the main menu and select the Auto Export 

page. Tap Open Folder to select a destination folder. 

 

 

Figure 157 Auto Export 

For example, after tapping the Open Folder button, you can select an external USB 

disk from the dropdown as a save destination for the UFF files and make it 

convenient to use them for ODS analysis.  

 

 

Figure 158 Select disk 
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6.6.4  Order tracking 

 

Double tap the Order Tracking icon on the home screen to activate dBX Analyzer 

and load the pre-set parameters for an Order Tracking test. With this template you 

can measure order traces, order spectrums, spectral maps, and orbits within the 

speed range of 400~3600 rpm.  
 

Connect an ICP accelerometer to channel 1 and connect the tachometer to channel 

PWR/TRIG. Press the Start / Stop key to start the measurement.   
 

Note: The order tracking will not work without the signal from the tachometer. 

 

 

Figure 159 Order Tracking view 

The pre-set parameters for this template are shown in the table below. To change the 

values of the parameters, enter the Setup menu. 

Table 5 Pre-set parameters  

 Ch 1 Ch 2 Ch 3 Ch 4 

Coupling ICP - - - 

Input range 5 V - - - 

Window Hanning - - - 

Sensor type Acceleration - - - 

Sensor unit g - - - 

Sensitivity  100 mV/g - - - 

Display unit mm/s - - - 

Filter 5 Hz HP - - - 



DBX ANALYZER MODULE 

Perform test from a pre-set template 

158 (235) SKF Microlog Analyzer dBX  

User Manual 

Revision E 

 

 

• Measured functions – Bode plot, Spectrum 

• Frequency – 10 orders 

• Resolution – 1/8 order 

• Speed range – 400 to 3600 rpm 

• RPM step – Event: Up and Down, Delta RPM: 10, Delta time: 5 seconds 

• Average – Linear 

• Overlap Level – Max% 

6.6.5  Orbit analysis 

 

Double tap the Orbit analysis icon on the home screen to activate dBX Analyzer and 

load the pre-set parameters for Orbit measurements. With this template, you can 

measure an orbit plot with channels 1 and 2 as the orbit pair. 

 

Connect Eddy Current sensors to channels 1 and 2 and connect the tachometer to 

channel PWR/TRIG. Press the Start / Stop key to start the measurement.  

Note that the Orbit measurement will not work without the signal from the 

tachometer. 

 

Figure 160 Orbit Analysis view 

The pre-set parameters for this template are shown in the table below. To change the 

values of the parameters, enter the Setup menu. 

 

 Ch 1 Ch 2 Ch 3 Ch 4 

Coupling DC DC - - 

Input range 20 V 20 V - - 

Window Hanning Hanning - - 

Sensor type Displacement Displacement  - - 
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 Ch 1 Ch 2 Ch 3 Ch 4 

Sensor unit um um - - 

Sensitivity  7.874 mV/um 7.874 mV/um - - 

Display unit um um - - 

Filter Off Off - - 
 

• Measured functions – Bode plot, Orbit  

• Frequency – 10 orders 

• Resolution – 1/8 order 

• Speed range – 400 to 3600 RPM 

• Event – Up and Down 

• RPM – 10 RPM   

• Time step – 5 seconds 

• Measurement Control – Both RPM and Time step 

6.6.6  Run up coast down 

 

Double tap the Run up coast down analysis icon on the home screen to activate 

dBX Analyzer and load the pre-set parameters for run up coast down measurements. 

With this template, you can measure vibration signals during a run-up or coast-down 

process and derive order traces, order spectrum, and spectral maps within the speed 

range of 400 rpm to 3600 rpm. 

 

Connect ICP accelerometer to channels 1, 2, 3 and 4 and connect the tachometer to 

channel PWR/TRIG. Press the Start / Stop key to start the measurement. 
 

Note: The Run up coast down measurement will not work without the signal from the 

tachometer. 

 

Figure 161 Run up coast down view 
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To display overall traces and waterfall plots, select the layout 2 and 3 icons from the 

Toolbar. 

 

Figure 162 Layout 2: Overall traces plot – example data 

 

Figure 163 Layout 3: Waterfall plots – example data 

6.6.7  Data recorder 

 

Double tap the Data recorder icon on the home screen to activate dBX Analyzer and 

load the pre-set parameters for raw data recording. With this template, you can 

throughput the measured signals into the hard drive continuously and save the raw 

data into raw data files for post-analysis.  

 

The measurement bandwidth of this template is set to 2 kHz.  You can change the 

setting when necessary. Connect ICP sensors to channels 1, 2, 3 and 4 and connect 

the tachometer to channel PWR/TRIG. Press the Start / Stop key to start the 

measurement.  
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Figure 164 Data recorder view – example  

 

Figure 165 Data recorder measurement – example  

Press the Start / Stop key to stop the recording and save the data to a project or 

data file.  

6.7 Working with Plots 

6.7.1 History and Live Data panels 

 

The History data view contains the data you add to the project, while the Live data 

view contains the data from real-time measurement or playback analysis. 
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You can find History Data and Live Data labels on the left-hand side of the display. 

Tap on a label or select the Data panel menu to open it. 
 

 

Figure 166 History and Live data  

When the History Data or Live Data views are not in use, they can be hidden. 

  

 

1. Arrange the hierarchic 

structure 

2. Expand all nodes 

3. Collapse all nodes 

4. Hide this view 

 

6.7.2 Create a plot 

 

To create a chart, first select a function from the History Data or Live Data view to 

show it in the display area. Use one of the following methods to create plot(s):  

 

1. Press the right-click key and select Open As > Single Plot or Multiple Plots. 

 4 3 2 1  1  2  3  4
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Open as a single plot will create a plot which contains all the channels under 

this node. Open as multiple plots will create an independent plot for each 

channel.  

 

2. Select a function or a channel and press the OK key to create a plot. 

 

6.7.3 Working with single-plot and multiple plot view 

 

You can display multiple plots in one display. Press the C key to enable active 

window selection.  

 

 

Figure 167 Multiple plot 

It will highlight the selected plot with a black frame. Use the navigation keys to move 

the red frame to a selected plot and press OK to maximize it.  
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Figure 168 Single plot 

Press OK again to restore it. The selected active window displays its title bar with 

blue colour, while the unselected window with grey. You can also tap on a plot to 

make it active. 

6.7.4 Displaying the plot menu 

 

Press the right-click key or tap for 2 seconds on the plot to display the plot menu on 

the active plot. With the plot menu, you can set up X, Y, and Z axes, select plot 

format, etc. Note that the content of the plot menu depends on the plot type. 

  

 

Figure 169 Plot menu 
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6.7.5 Plot menu of a time waveform plot 

 

 

 

• X-axis 

 

o Select Linear or Log scale 

o Log Base – Specify the log base for log axis display 

o Unit – Select Sec, Min, or Hour 

o Scale – Select auto scale or fixed scale 

 

• Y-axis 

 

 

o Scale – Select auto scale, fixed scale, full scale, or a fraction of the 

full scale 

o Overall Detection – Select rms, peak or peak-to-peak as the 

detection of overall values (displayed in the side frame) 

 

• Plot 
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Select the plot format as Linear, XY or Circular. 

 

o Linear plot 

 

 

o XY plot – Available when two waveforms are shown in the same plot 

 

o Circular plot – Require you to input the number of gear teeth and the 

rotation speed to display the waveform in circular plot format 
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• Windowing – Select to display the waveform with or without the windowing 

function. The plot below shows an example of a time waveform with a 

Hanning window. 

 

 

• Filter – Specify a band pass filter and apply it to the waveform. Select 

Unfiltered to undo it. 

 

 

 

• Cursor – Press the cursors key to select a cursor type.  

 

• Legend – Select to show or hide the channel legend. 

 

• Mathematics – Tap the mathematics icon on the Tools bar to select 

mathematical operations to conduct post-analysis. 

 

• Frame – Show or hide the side frame. The detailed information and cursor 

information is shown in the side frame. You can also tap the icon on the Tool 

bar to show or hide the side frame.  

Show or hide the Caption an 
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• Copy image to clipboard – Copy the plot to clipboard as an image. 

 

• Save image file – Save the plot as an image file. 

 

• Export – Export the data of the plot to a specified format. You can also 

export the data of the project from the File menu. 
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• Property – Edit plot properties. 

 

 

 

6.7.6 Plot menu of an auto spectrum plot 

 

 

 

• X-Axis  

 

 

o Select Linear or Log scale. 

o Log Base – Specify the log base for log axis display. 

o Unit – Select Hz, CPM or Order. 

o Scale – Select auto scale or fixed scale. 
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• Y-Axis 

 

 

o Linear, log or dB – Select the scale type of the Y axis.   

o Log Base – Specify the log base for log axis display. 

o Scale – Select auto scale, fixed scale, full scale, or a fraction of the 

full scale. 

o Detection – Select the detection type of the Y-axis. 

o Overall Detection – Select rms, peak or peak-to-peak as the 

detection of overall values displayed in the side frame. 

 

• Plot – Separate or overlap. Used when there is more than one trace in the 

plot. 

  

• Cursor – Press the cursor key to select a cursor type.  

 

• Legend – Select to show or hide the channel legend. 

 

• Mathematics – Tap the mathematics icon on the Tools bar to select 

mathematical operations to conduct post-analysis.  

 

• Frame – Tap and select one of the options:  

 

o Show or hide the side frame. The detailed information and cursor 

information is shown in the side frame. You can also tap the icon on 

the Tool bar to show or hide the side frame.  

o Show or hide Caption. 

o Show or hide Border. 
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• Copy image to clipboard – Copy the plot to clipboard as an image. 

  

• Save image file – Save the plot as an image file. 

 

• Export – Export the data of the plot to a specified format. You can also 

export the data of the project from the File menu. 

 

• Property – Edit the various properties of the plot. 
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6.7.7 Plot menu of a complex spectral plot 

 

A complex function contains both amplitude and phase.  

For example, the FRF, Cross power spectrum, and Complex spectrum are the 

typical complex functions which contain amplitude and phase data. 

 

• Plot – Select plot format.  

 

      

 

 

 

 

Figure 170 Plot types – example  

1. Linear plot 

2. Polar plot 

3. Bode plot 

 1  2

 3
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Figure 171 Accelerance / Mobility / Compliance plot of a FRF function 

6.7.8 Plot menu of a 3D plot 

 

 

 

• Z-Axis – Select Linear, Log, Count, Time, or RPM. 

 

• Plot – Select plot format: Waterfall, Intensity, or Overlap.  
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Figure 172 Waterfall plot 

 

Figure 173 Intensity map 

 

Figure 174 Overlap plot 
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• Cursor – Select the cursor type from X, Y, Dual X, Dual Y and All 

X & Y cursor shown on the graph with time selected in the Z-Axis. 

 

 

o Cursor/Capture – Select to Capture the trace where the 

cursor is on and display it from the Live data panel.  

 

  

 

 Figure 175 Cursor capture 
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6.7.9 Zoom in, Zoom out and Pan 

 

• Zoom in and out – Press the zoom-in and zoom-out keys to zoom in 

or zoom out a plot along the X-axis from the cursor position.   

Or use your index finger and thumb to zoom in. 

 

 

• Auto Scale – To auto-scale an axis, double tap the axis legend area. 

 

• PAN – Use two fingers to drag the plot. 
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6.7.10  Add an additional signal to the plot 

 

To add additional signal to the plot, select a signal from the Live data panel or the 

History panel and drag and drop it into the plot.  

 

 

 Figure 176 Add signal to the plot 

6.7.11 Toolbar functions 

 

The toolbar on the top of the screen provides a shortcut to the most commonly used 

functions of the dBX Analyzer. Use the touchscreen feature to work with the toolbar. 

 

The toolbar functions are divided into several groups: 

 

Measurement control 

 
Start a measurement 

 
Pause a measurement 

 
Stop a measurement 

 

 

File functions 

 
New project, for more information refer to File menu 
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File functions 

 
Open project, for more information refer to File menu 

 
Save project, for more information refer to File menu 

 
Add data, for more information refer to File menu 

 

 

Setup 

 

Open the Setup view 

 

 

Plot format 

 

Toggle different plot format for the active plot  

 

 

Mathematical operation 

 

Open the mathematical operations menu to perform post analysis 

on the active plot 

 

 

Layout management 

 

Select from the 3 available layouts to arrange the plots 

 

 

Side frame 

 

Display or hide the side frame of the active plot 

 

  



DBX ANALYZER MODULE 

Working with Plots 

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

179 (235) 

 

 

Cursor and cursor functions 

 

When the Single cursor is active, tap this icon to add one more 

single cursor to the plot. You can add more single cursors to the 

plot when needed. 

 
Display or hide single cursor 

 
Display or hide harmonic cursor 

 
Display or hide dual cursor  

 
Display or hide sideband cursor. 

 

Enable or disable the Move peak cursor feature.  

When the Move peak is enabled, the cursor will stay at a peak. 

 

Display or hide the cursor marker, for more information refer to 

Show or hide cursor marker 

 

 

File functions 

 
Tile horizontal 

 
Tile vertical 

 
Close all  

 

6.7.12  Status bar 

 

 

 

The status bar shows the measurement information, which includes the average 

number, triggering status, RPM reading, etc.  

The channel status with four colour icons is shown on the right side of the status bar. 

 

• Green – normal  

• Blue – ICP bias abnormal 

• Red – overloaded 
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6.8   Working with cursors 
 

Select a cursor using one of the following methods: 

 

• Select a cursor from the Plot menu. 

• Select a cursor from the Toolbar icons. 

• Press the cursor taggling key repeatedly until the desired cursor is selected. 

6.8.1 Cursor types 

 

• Single cursor – The basic cursor type which shows only one cursor value at 

a time. 

 

 

o  Add cursors – Add a single cursor to the plot. It is possible to 

add multiple single cursors. To add single cursors to the plot, tap 

the Add single icon from the Toolbar.  

 

 Harmonic Cursor – Places a main cursor with its harmonic 

(orders) of the cursor position. This helps to understand the harmonic 

frequencies of the measurement. 
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•  Dual cursor – Places two cursors to shade an area D1 – D2. 

 

 

 

•  Sideband Cursor – Will display cursor labels S, S1 and S2 with 

harmonic frequencies. 

 

 

 

•  Jump peak – When Peak Cursor is selected, and you move the 

highlighted cursor on the graph, it will always move from one peak to another. 
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6.8.2  Show or hide cursor marker 

 

 This action will display cursor values on the graph, and it can be helpful to 

highlight a particular value on the graph. 

 

  

6.8.3  Move cursors on the plot 

 

Select an active cursor 

To move a cursor, tap the cursor to activate and highlight it.  

Once activated, use the navigation keys, or drag and drop the cursor using the 

touchscreen to move it to a specific position on the plot. 
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6.8.4 Moving Dual Cursors 

 

To move dual cursors together, first, highlight D1 and D2 by tapping somewhere 

between D1 and D2. When the dual cursors are active, D1 and D2 are highlighted. 

 

To move either D1 or D2 independently:  

 

1. Select the edge of D1 or D2  

2. Drag and drop it to the desired location  

 

To move D1 and D2 together:  

 

1. Select either the green arrows from the Chart toolbar to move left or right,  

or tap somewhere between D1 and D2 to move it.  

 

 

  

Use the same procedure for sideband cursors.  
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6.9   File menu 
 

Use the File menu to manage your data files in the dBX Analyzer. There are some 

basic principles that you can use throughout the software. 

 

 

6.9.1 Project: New, Open, Save, and Save Project as 

 

A project is an accumulation of setup parameters and measured data. When starting 

work with the dBX Analyzer, create a new project or open an existing project. Once a 

project is created, click Save Project or Save Project As… to save it to another 

project file.  

 

Select Project from the main menu and press OK to display its sub-menu. With the 

sub-menu, you can create a new project, open an existing project, save a project, or 

save the project with a different project name.  

 

 
 

• New – Select to create a new project. 

• Open – Select to open an existing project. 

• Save – Select to save the open project. 

• Save as – Select to save the open project with a new project name. 

 

Note that the Recorder raw data files are saved separately. To move a project with 

Recorder raw data files to a different folder, select Export > Export project.  
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6.9.2 Data File: Save or Add data 

 

Select Save from the main menu and press OK to display its sub-menu. With the 

sub-menu, you can save the measured data to a file or add saved data to this 

project. 

 

 

• Save – Select to save the test data to a file.  

A data file contains test data only, it does not contain display or measurement 

parameters as a project file does. When saving data, a pop-up window will 

show the files and the path where they will be saved on your Analyzer device. 

Saved data can be added to another project for further application. 

 

Figure 177 Save Data    

• Add – Use this function to add dBX Analyzer format data to your project. 

When you select Add data, you can specify the data files you wish to add. 

For example, you can add a raw data file to this project for playback analysis. 

The added data file will be displayed in the History data panel. 

6.9.3 Configuration: Save to default 

 

Saves various setup parameters to a file called default.nst. Every time a new project 

is created, the default settings will be applied to this new project.   

6.9.4 Save Options 

 

Save Options allows the opportunity to specify more items on how the data can be 

saved with prompted file names, file path, analysis data or file exporting. This is 

useful when you have many files and want to specify a particular feature or feature 

subset in saving the files for easy recall. 
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• File Name – To define the default file name prompted by the system select 

Save Option > File Name  

 

o Edit Prefix, Postfix and Note used in the file name menu. The dBX 

Analyzer will use the setup to prompt a file name automatically while 

you are saving a project or data file. For example, you can select 

Channel ID to generate file names during a modal or ODS test. Select 

an item and use Up and Down buttons to change the order of the file 

name. 

 

.  

Figure 178 Save Option – File Name view    

• Analysis Data – Enable or disable the auto save function after each 

measurement from this menu. Select the data types and destination folder(s) 

for the auto save function. 

 

o Auto Save – If selected, your selected analysis data will be 

automatically saved to the specified folder(s) each time the 

measurement is complete. 

o Auto Prompt – If selected, it will prompt you to save the data file(s) 

after each measurement. 

o Open Folder – Select destination folder(s) to save the data file(s). 

 

 

Figure 179 Save Option – Analysis Data view    
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• Auto Export – When Auto Export is enabled, dBX Analyzer will export 

measured data to the selected folder with a specified format whenever a data 

file is saved. Click Add to add new setup. You can enable multiple export 

setups at the same time. 

Select setup and click Remove to remove it from the list. 

For example, you can enable the UFF file auto export feature during a modal 

or ODS test procedure. These exported UFF files can be imported to a 3rd 

party Software for ODS or Modal analysis. 

 

Figure 180 Save Option – Auto Export view  
 

6.9.5 Export  

 

• Export file 

  

o Format – To export files in other file formats, from the Format 

dropdown, select one of the options: 

▪ UFF – Time Waveform format. File extension is .uff  and it 

stands for universal file format 

▪ ASCII – Data record file format. File extension is .TXT  

▪ CSV – Data record file format. File extension is .CSV 

▪ XML – Extensible Markup Language. File extension is .xml  
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o Function – Select specific functions to be exported. Export options 

are Time Waveform, Complex Spectrum, Auto Power Spectrum, 

Cross Power Spectrum, FRF, Coherence, Cepstrum, 

Demodulated Spectrum and more. 

 

 

 

o Option – Select export options 

 

• Batch export files – Select to convert selected files in a selected folder into 

a specific format.  This feature is useful for converting a large number of files 

at a time. 

 

1. Tap Select Folder to select the folder where the data files are stored. 
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2. Check the File Name column to select the data files in the specific folder. 

 

3. Tap the Format dropdown to select the file formats you wish to convert: 

UFF, ASCII, CSV, XML. 

 

4. Tap Function to select the measured functions you wish to convert. 

 

5. Tap Option to select the options for the data conversion. 

 

6. Tap the Assign Column to assign the status (selected or unselected) to 

other columns. 

 

7. Tap Convert to perform the file format conversion. 

 

8. Tap Close to exit the view.  

 

• Export project – If a project contains a Recorder raw data file(s), you’ll need 
to export the project before you move it to another folder. That is because the 

Recorder files are saved separately and are not included in a project file.   

6.9.6 Demo 

 

Select Demo/Grinder to perform a playback analysis with the raw vibration data 

recorded from a bench grinder.   

6.9.7 Recent projects  

 

List the file paths of the most recently used projects. It is a helpful tool to help find the 

data files and most recent dBX Analyzer projects. 

 

 

Exit – Tap to Exit the Analyzer module. 
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6.10  Mathematics menu  
 

Once you have decided on the data to plot, you can now look at different aspects of 

the data on the plot with mathematics. An example is to convert the data from 

acceleration to displacement. 

 

Tap the mathematics icon from the Toolbar to display a dropdown menu and select a 

mathematical operation for the active plot. 

 

 

Figure 181 Mathematics menu    
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6.10.1 Integration / Differentiation 

 

 

Figure 182 Auto Spectrum – FFT file example    

In the plot below, we will convert g’s (acceleration) to um (displacement) by selecting 

integration two times. This will convert this plot information to displacement.  

 

To return to g’s, select Differentiation. 

 

Integration pressed once – The plot shows mm/s or Velocity. 

The integration function is selected again, now the plot shows um or displacement of 

the signal. 

 

Figure 183 Integration function – example     

 

1. After two times integration  

2. Filter out low frequency noise  

 1  2
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6.10.2 Fourier transform / Inverse Fourier transform 

 

Inverse Fourier transform converts the plot from Hz to Time, as shown in the plot 

below. To go back, select Fourier Transform. 

  

Figure 184 Fourier transform – example    

6.10.3 Applying filters 

 

Adding filters to the data is very helpful for eliminating or reducing noise in your 

measurement or looking at the data differently. Several filters are available.  

 

• Band pass filter – Filters out frequencies outside the specified band. Place 

the cursor on the filter’s edge to slide to desired placement on the plot. 

 

 

Figure 185 Band pass filter – example    
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Figure 186 Before Band Pass applied (left) After Band Pass applied (right)   

 

 Band notch filter – Filters out the area between the specified band. 

 

 

Figure 187 Before Band Notch applied (left) After Band Notch applied (right)   
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• High pass filter – Passes high frequencies well but attenuates (i.e., reduces 

the amplitude of) frequencies lower than the filter's cut-off frequency. 

 

 

 

Figure 188 Before High Pass applied (left) After High Pass applied (right)   
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• Low pass filter – Passes low-frequency signals but attenuates (reduces the 

amplitude of) signals with frequencies higher than the cut-off frequency. 

 

 

 

 

Figure 189 Before Low Pass applied (left) After Low Pass applied (right)   

• Scaling – Enter a value to scale the data in the active window.  
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6.10.4 Window functions for Time Waveform 

 

To remove this leakage error, it may be necessary to apply a window function to the 

time waveform before conducting FFT. Because there are many shapes of signals, 

there are different windowing functions to best suit the situation.  

 

 

Figure 190 Windows type selection 

From the dropdown menu, select Rectangular, Hann, Flattop, Force, Exponential, 

Hamming, Bartlett, Blackman, or Kaiser window.  

 

 

Figure 191 Right-click menu – Windowing  

After a window is applied to a time waveform, the waveform display remains 

unchanged. To see the windowed waveform, press the right-click key and select 

Windowing > Show Windowed to display it as follows. 
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Figure 192 Apply windowing view – example   
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6.11  Mode menu  
 

Use the Mode menu to select the measurement mode you wish to perform. Select 

one of the five modes: Real Time Analysis, Raw Data Recorder, Real Time + 

Recorder, Playback Analysis, or Data Review.  

 

 

 

The selected mode will also work with different types of measurements. To measure 

FFT real time with Octave analysis, select Real Time Analysis. 

6.11.1 Real Time Analysis  

 

In Real Time Analysis mode, data is measured real time.   

6.11.2 Raw data recorder 

 

A Raw Data Recorder measurement records the raw data without post-processing.  

It is useful to capture the real event compared to taking a snapshot as an FFT 

analysis does.  

Raw Data Recorder is designed to capture data continuously and transfer the raw 

signal to the hard drive. The raw data file can be replayed in the playback mode to 

perform post-analysis.  

 

Select File > Save data to save the raw data file for playback analysis in the future.  

 

A Recorder raw data file consists of two parts:  

 

• .nrd files contain the header information  

• .nra file(s) contains the measured data 

 

6.11.3 Real time + Recorder  

  

Real Time + Recorder combines Real Time FFT, Order Tracking and a Raw Data 

Recorder. This mode intends to take FFT and/or Order Tracking data in real time and 

capture the Raw data of your measurement as a raw data file at the same time. 
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6.11.4 Playback analysis 

 

Use this mode for review and analysis of raw data record files. Use the playback 

mode to replay a saved raw data file as live data. The playback mode allows you to 

recreate the event as if you were on-site measuring in real time. 

6.11.5 Playback analysis by adding a raw data file 

 

To perform a playback analysis, follow the instructions below. 

 

1. To create a new project, select File > New Project. 

 

2. Select Mode > Playback Analysis. 

 

3. To add a raw data file to the project, select File > Add data. 

Note that the raw data consists of two parts:  

a. The .nrd file contains the header and file information 

b. The .rna file contains the raw data itself 

 

 Always select the .nrd file and add it to the project. 

 

 

 

4. The added raw data file(s) is now visible in the History data panel. 

 

 

 

5. From Setup > Playback Source select the raw data file. 
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6. Go to the Setup menu and set the parameters (or load a setup file from 

the File menu) for your analysis. 

 

7. Press Start / Stop to perform the playback analysis. 

6.12  Playback mode 
 

Playback mode is used for review and analysis of raw data record files. Playback 

mode is used to replay a saved file as if it was live data. Playback mode allows you 

to recreate an event as if you were on-site performing the measurement in real time. 

6.12.1 Performing a playback: 

 

1. Set the mode to playback analysis. 

 

2. Add a raw data file. 

 

3. Adjust the parameters: go through the analyzer Setup menu and set up FFT 

or Order tracking parameters. 

 

4. Create plots from the Live Data panel and set up the display layout(s).  

 

5. Press Start on the measure toolbar to begin the playback of your raw data 

recorder file. 

 

6. Press Stop on the measure toolbar to stop the measurement. 

  

7. Perform mathematics, place cursors, notes etc. save/export the file or create 

reports as needed. 

6.12.2 Playback analysis after raw data recording 

 

Another way to perform a playback analysis is to change the instrument mode to 

Playback Analysis right after the raw data recording from Recorder or Real-time + 

Recorder mode.    
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1. After the recording, the recorder function is available in the Live data panel. 

Move the cursor to highlight the Recorder, right-click to display the options 

and select Add to History Data. 

 

 

 

2. In the History data panel, you can see the added raw data.  

 

 

3. Change instrument mode to Playback Analysis and select the Source data 

file from Setup > Playback source. 

 

 

 

4. Set up the parameters and start the playback analysis. 
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6.12.3 Data review 

 

Use the Data review Mode to review and perform analysis on the previously 

measured data files. 

6.13  Configuration menu 
 

The Configuration menu contains three setup menus related to performing a 

measurement:  

 

• Analyzer Setup 

• Channel Setup 

• Engineering Unit  

 

Specific module setups are FFT, Recorder, Octave, and Order Tracking. 

6.13.1 Analyzer setup 

 

Use the Analyzer setup to assign the selected channels to desired analysis 

module(s), determine the tachometer channel, and set up the tacho sensor. You will 

notice available analysis modules under the authorization column, depending on 

what was purchased. 

 

 

Figure 193 Analyzer Setup view – example    

With this Analyzer setup menu, you can assign an analysis software module to each 

channel.  

In the example above, Channels 1, 2, 3 and 4 are assigned for FFT analysis, and 

Channels 2 and 3 for Order Tracking analysis.  

The tachometer channel is used for measuring a tachometer signal.  

 

Note: To perform Order Tracking analysis, at least one tachometer channel must be 

enabled.  
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As the real-time measurement is started, both analysis modules will run parallel at 

the same time. 

 

• Save to Default – Save all the current settings to a default file (default.nst).  

• Tacho Setup – Opens the Tachometer Setup screen. 

 

6.13.2 Channel setup 

 

• Channel ID is divided into two groups: 

 

o Modal uses channels IDs for modal analysis or ODS analysis, where 

you assign the Point number and the direction to each channel.  

 

 

Figure 194 Channel Setup view – Modal – example    

o Machine – Labels are given for the type of machine used.  

 

 

Figure 195 Channel Setup view – Machine – example    
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• Channel – Displays the channel number. 
 

• Coupling – Set sensor coupling types. Select AC, DC or ICP. 
 

• Input Range – Set input voltage range (5 V or 20 V). 
 

• Window – Set the window function: Uniform, Hanning, Flattop, Force, 
Exponential, Hamming, Bartlett, Blackman, Kaiser. 
 

• Node – Set measurement location number. 
 

• Direction – Set measurement location direction  

(Combo: +X/-X/+Y/-Y/+Z/-Z+R/-R/+T/-T/+P). 

 

• Advance Number – Sets the advance number for the next measurement. 

 

• Label – Enter the channel label as memo. 

 

• Force Factor – Enter the force window width. In the above example, the 

Force window width is 0.1 = 10% 

 

• Exp. Factor – Enter the attenuation rate at the end of the time block when an 

exponential window is selected.  

In the above example, Exp. Factor = 0.1 = 10%. That means at the end of the 

time block, the weighting value is equal to 0.1 

 

Definition of Exponential 

function 
x(t) = EXP (-Bt) 

Definition of Exponential 

factor X 

X = EXP (-Bt) at t = T  

Where T is the length of the time block.  

X is the attenuation rate of the exponential window 

at the end of the time block. This should be a real 

number between 0 and 1 

 

• Assign Single Column – Repeats selected data in that column. 

 

• Assign all columns – Repeats all columns with data in the selected channel. 

 

• Save to Default – Save the current setup as the default, same as selecting 

File > Setup/Save to Default. 

 

• OK – Save the setup and exit the setup view. 

 

• Next – Enter the next setup page. 
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6.13.3 Tachometer Setup 

 

Understanding the Tachometer input 

A pure TTL signal is typically a 0–5 V signal that uses a tachometer and optical tape 

to generate the “tach” or signal for the 1x per rev signal. Microlog dBX is equipped 
with a tachometer input channel and a built-in power supply, which can power SKF 

laser tachometer sensor directly. Besides that, you may use one of some of the 

analogue input channels as tachometer input. Each revolution is calculated based on 

the zero crossing of the phase angle. The tachometer waveform can be observed in 

the channel designated in the FFT. You can have more than one tachometer input if 

desired. 

 

Tap Tacho Setup and in the pop-up window you can enter various parameters for 

proper triggering. 

 

Figure 196 Tacho setup – example 

• Tacho Channel – Select a channel from the dropdown. The available Tacho 

Channels are defined in the Analyzer setup menu. 

 

• Trigger Method – Time or Spectrum. 

If a tachometer sensor is used, always select Time and the Tacho Channel 

will be triggered from the time waveform. If no physical tachometer sensor is 

used, and you still need to measure the rotation speed, use Spectrum 

triggering. 
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6.13.4  Time triggering setup 

 

 

Figure 197 Trigger Method Setup view – example 

• Trigger Mode – Manual for manual setup, Auto for Auto-detection. For using 

a standard TTL tachometer sensor, Auto detection is recommended. If you 

are using a non-TTL sensor, which also contains noise, select Manual, and 

Analyzer provides a very flexible setup to detect the tachometer correctly. 

 

Figure 198 Tachometer detection – example 

 

1. Tacho signal 

2. Trigger level 

3. Trigger point 

4. Hysteresis 

5. Hysteresis level 

6. Reference level 

 

• Hysteresis(mV) – Type the Hysteresis voltage level.  

This setting is used to exclude fake signals when there is noise from the 

tachometer sensor. In the illustration plot above, the tachometer signal is 

raised from the Reference level and reaches the Trigger level at 

the Triggering point. The Hysteresis defines the minimum “depth of drop” 
after a triggering. If does not drop down to the hysteresis level again, any new 

triggering will be ignored. 

 

• Slope – Select trigger slope as positive (ascending), negative (descending) 

or both. 

 

 6

 5
 4

 3 2

 1
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• Trigger Type – Select by millivolt level or by percentage. 

 

• Trigger Level – Select a percentage of full range, or a voltage level. 

 

• Holdoff Unit – Select millisecond or ratio. 

 

• Holdoff Time – Select a ms (milliseconds) number or ratio number. 

Holdoff time is used to exclude Noise too. It defines the minimal time span 

between two triggering points.  

 

For example, if Holdoff time is set as 20 ms, the maximum rotation speed 

would be 1/20 ms = 50 Hz = 3000 RPM.  

 

Any tachometer signal providing a number higher than 3000 RPM would be 

considered as Noise and ignored. 

6.13.5  Spectrum Triggering setup 

 

 

Figure 199 Trigger setup – example 

When here is no physical tachometer sensor connected to your dBX Analyzer: 

 

1. Select the Trigger method as Spectrum  

2. Click Setup to show the setup menu 

 

Input the Peak Order with a number. For example, if Peak Order is specified as 1, 

dBX Analyzer will take the frequency of the maximum peak as order #1 and then 

calculate the rotation speed from the frequency of that peak. 

 

The following example shows how to measure the rotation speed when imbalance 

vibration is the dominating signal. Another example for conducting order tracking 

analysis on a 4-cylinder 4-stroke engine, which has a dominant signal in the 2nd 

order, you can set Peak Order as 2. 
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Figure 200 Auto Spectrum Rotation Speed – example 

1. Noise level 

 

Note: When Spectrum trigger is selected, there is no phase information available.  

 

6.13.6 Engineering unit setup 

 

From the toolbar, select Setup > Engineering Setup.  

Engineering Unit setup is used for selecting the sensor type, sensor units, 

sensitivity, and other parameters for your measurement.  
 

 

Figure 201 Engineering Unit view – example 

• Channel – Shows channel number generated by the Analyzer Setup. 

 

• Sensor Type – Set sensor type: Voltage, Acceleration, Velocity, 

Displacement Force, Pressure, Temperature or Custom.  

 

• Sensor Unit (SU)  

o Acceleration: g, m/s2 

o Velocity: mm/s, in/s, cm/s 

 1
 1
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o Displacement: mil, μm (um) 

o Force: N, g 

o Sound: Pa 

o OFF: Volt 

 

• Sensitivity – Enter the sensors’ sensitivity in millivolts per sensor unit (SU). 

 

• Display Unit – The displayed unit can be different from the sensor unit to 

display the units in something other than what is calibrated. Select the 

Display unit based on the Engineering Unit Table. 

 

• dB Reference – dB reference value A0: e.g. A0 of Sound signal: 2e-05 Pa. 

 

• Weighting – Add a weighting function to a selected channel. For example, 

weighting A, B, C and D are used for acoustic measurements. ISO 2631 is 

used for complete body vibration measurements, and ISO 6954 is used for 

vibration evaluation concerning habitability on passenger and merchant 

ships. 

• Gain – Sets the Gain  

 

• DC Offset – Set DC Offset  

 

• Filter – Applies a high pass filter to the measurement. Select OFF, 0.1Hz,  

0.5Hz, 1Hz, 2Hz, 5Hz, 10 Hz or 20Hz). If the display unit is derived from 

integration, use a high pass filter to filter out the ski slope noise at the low-

frequency zone. 

 

• Assign Single Column – Repeats selected data in that column. 

 

• Assign All Columns – Repeats all columns with data in the selected 

channel. 

 

• Detection – Set signal detection to: RMS, Peak, or Pk-Pk. 
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6.13.7 FFT setup 

 

From the toolbar, select Setup > FFT setup. In this section, you can select 

Function, Frequency, Averaging, Trigger and Map. 

  

• Function 

 

 

Figure 202 FFT – Function view – example 

Select Time Waveform, Complex Spectrum, Auto Spectrum, Cross 

Spectrum, FRF, Coherence, Power Cepstrum, Overall Level, Power 

Spectrum Density, Mean Trend or Rate Trend. 

 

o Auto Spectrum – Also known as the Power Spectral Density (PSD), 

represents the distribution of power across the frequency components 

that make up the signal. It is derived from the Fourier transform of a 

signal and provides information about the energy present at different 

frequencies within a single time series.  

 

Use: It is primarily used to identify dominant frequencies and their 

amplitudes in a vibration signal. 

 

o Cross Spectrum – Used to analyse the relationship between two 

different time series. It provides information on how the two signals 

are correlated in the frequency domain. 

 

Use: It helps in identifying common frequencies between two signals 

and understanding the phase relationship between them. This is 

particularly useful in identifying how different parts of a system 

interact with each other. 

 

o Complex Spectrum – Includes both the amplitude and phase 

information of a signal. It is represented as a complex number, 

combining the real and imaginary parts of the Fourier transform. 

 



DBX ANALYZER MODULE 

Configuration menu 

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

211 (235) 

 

 

Use: It provides a more comprehensive view of the signal, allowing 

for the reconstruction of the original time-domain signal from its 

frequency components. 

 

o Coherence – A function used to examine the relationship between 

two signals. It is a real function with values ranging between 0.0 and 

1.0. 

 

Use: It is commonly used in frequency response function 

measurement to check the quality of signals and signal 

measurements. 

 

o Frequency response – Frequency response of a system is a 

quantitative measure of the magnitude ratio and phase difference 

between the output and input signals. 

 

Use: It is widely used in investigating resonance problems of a 

structure, conducting experimental modal testing, and ODS testing 

 

o Power Cepstrum – A tool used in signal processing to analyse 

periodic structures within a signal. It is defined as the inverse Fourier 

transform of the logarithm of the power spectrum of a signal. 

The Power Cepstrum is particularly useful in identifying periodicities 

in the frequency domain, which can be related to echoes or 

reflections in the signal.  

 

Use: To detect periodic components in mechanical vibrations. 

 

Select the gE Envelope filter(s) and the corresponding functions: overall 

trend, gE waveform or gE spectrum. You can see the selected functions in 

the Live data panel. 

 

o Enable Zero Mean – Enabling Zero Mean will remove the DC offset 

of the time waveform digitally. 

o Reference Channels – dBX Analyzer always uses channel 4 as the 

reference channel. The reference channel is used to calculate the 

FRF and Cross-Spectrum, which are used by the ODS analysis. 

 

o Tacho – Select a tachometer for the FFT measurement. This feature 

will be used for controlling the RPM step during a Waterfall 3D 

measurement. Note that the tachometer needs to be selected from 

the Analyzer setup in advance. 

 

o gE Filter – Select gE Filter(s) for Enveloping analysis. You can select 

to measure gE Overall Trend, gE Envelope Time Waveform or gE 

Envelope Spectrum for each gE filter. 
 

• Frequency – Sets the Frequency Band, Resolution, Zoom FFT, and Overall 

Frequency Band. 
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Figure 203 FFT – Frequency view – example 

o Frequency Band – Set the Frequency Bandwidth: 50 Hz, 100 Hz, 

200 Hz, 500 Hz ,1 kHz, 2 kHz, 10 kHz, 20 kHz or 40 kHz.  

 

o Resolution – Select the number of resolution lines. 

 

o Zoom FFT – Check to enable zoom FFT. 

 

o Start Frequency – Enters the initial start frequency for zoom FFT  

(It will not work if the Zoom FFT is not selected.  

 

o Overall Frequency Band – Enters the frequency band of overall 

level. The overall level is calculated within the band between F1 and 

F2 from an FFT Spectrum. 

 

o Status  

▪ Start – Displays the start frequency. 

▪ Stop – Displays the ending frequency. 

▪ Delta f – Frequency resolution.  

▪ Resolution – Lines of resolution.  

▪ Zoom FFT – Zoom FFT start frequency. 

 

• Average – Set the averaging for the FFT measurement.  

Select: Spectral or Time Average, Average Type, Average Count and 

Overlap Level. When performing modal measurements, select Overload 

Reject and Preview. 
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Figure 204 FFT – Average view – example 

o Average  

▪ Average Off – No averages taken.  

▪ Spectral Average – Averages data in the frequency domain. 

▪ Time Average – Averages data in the time domain. 

 

o Average Type – Select Linear, Exponential or Peak Hold. 

 

o Average Count – Use the dropdown menu or the slider to set the 

average number. 

 

o Overlap Level – Use the dropdown menu or the slider to set the 

overlap percentage. 

 

o Overload Reject – Check the box to reject an overloaded signal. 

 

o Continuous save spectrum (non-stop) – Enabling this option will 

auto-save the spectrum to a specified folder after the average number 

is achieved, and then it will perform measurements repeatedly.  

Press the Start / Stop key to terminate the procedure. The specified 

folder can be set from the File > Save option. 

 

o Delay (Sec) – Tap to enter the time value in seconds for 

measurement delay. When the signal is not stable at the beginning of 

a measurement, set a delay time to skip that unstable phase. 

 

• Trigger – The Trigger setup is used to trigger or begin a measurement.  

A trigger signal is also used as the reference of phase measurements.   
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Figure 205 FFT – Trigger view – example 

o Type of Trigger – Select Off, or Channel. 
 

o Trigger Source – Select channels for the trigger source. 
 

o Trigger Slope – Select either positive or negative slope. 
 

o Trigger Level – Use the dropdown menu or the slider to set the 

trigger level. 
 

o Preview – Check the box to open the Signal Preview function. A new 

window for every measurement will open, showing the Time 

Waveform data. Select Accept or Reject the measurement during 

the averaging process. This feature is useful when doing a bump test 

and checking the signal quality before accepting it. 

 

  

Figure 206 Channels Overplayed (left) Channels Separated (right)   

o Separate – Each channel will be separated instead of overlaid. 

 

o Trigger Delay (%) – Use the dropdown menu or use the slider to set 

the trigger delay. A negative trigger delay is useful for capturing the 

complete waveform of a bump test. -3% to -5% trigger delay is 

suggested for such applications. 
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• Waterfall – 3D Waterfall functions for the FFT measurement can be set for 

Time Waveform, Complex Spectrum, Auto Power Spectrum, and Cross 

Power Spectrum. The sampling rate is chosen based on the RPM and 

bandwidth.  

 

 

Figure 207 FFT – MAP view – example 

o Waterfall functions – When the Waterfall Function box is checked, it 

will enable 3D waterfall measurements for Time Waveform, 

Complex Spectrum, Auto Spectrum, Cross Spectrum and 

Envelope Spectrum. 

 

o Free Run – If the Free Run box is checked, it will cause a 

measurement to continue until the entered total number of counts or 

time is reached. 

 

o Armed by Time Step – Checking the Armed by Time step will cause 

measuring every specified period. The measurement will continue 

until the time entered or the total number of counts is reached. 

 

o Armed by RPM Step – If the Armed by RPM Step box is checked, a 

measurement is taken whenever it reaches a specified RPM step. It 

will begin when the Start RPM entered is reached and will stop the 

measurement when the Stop RPM entered is reached. Users can set 

the Start, Stop and Delta RPM.  

 

o Armed by both – Enables the measurement controlled by both  

time / rpm. 

 

6.13.8 Order Tracking setup 

 

From the toolbar, select Setup > OT Setup.  

In this view, you can select Function, Frequency, and Average.  
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Figure 208 Order Tracking view – example 

• Function – Select measurement functions from Bode Plot, Spectrum, 

Waterfall, and Orbit. And select a tachometer channel, which was selected 

previously in the Analyzer setup menu. 

 

o Bode Plot Setup – When Bode Plot function is selected, you may 

edit the trace properties from the sub-menu.  

▪ Add – Add Bode Plot. 

▪ Edit – Edit the selected Bode Plot. 

▪ Remove – Remove the selected Bode Plot. 

 

o Add Bode Plot – Select Add Bode Plot to open the Bode Plot 

Setup menu. Then select the channel(s) and type of Bode Plot you 

want to add to the measurements. A Bode Plot could be the overall 

trend, or an order component measured over the specified speed 

range. Note that an overall trace does not contain phase information. 

 

Figure 209 Bode Plot Setup – example 

o Orbit Setup – The three symbols to the right are Add an orbit, Edit 

selected orbit and Remove orbit. 

▪ Add – Add orbit. 
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▪ Edit – Edit the selected orbits. 

▪ Remove – Remove the selected orbits. 

  

Select Add or Edit to enter the Orbit setup. An orbit is the XY plot of signals 

from selected channel A (X) and channel B (Y). To make the orbit and 

centreline plots show measured data in accordance with the actual geometry 

of the rotating machine, you need to specify the angular location of the 

sensors by entering the Angle A and Angle B.  

 

Enter the Initial (Init) Gap value if shaft centerline is to be measured. 

 

 

Figure 210 Angular location of the sensors – example 

• Frequency 

 

 

Figure 211 OT – Frequency view – example 

 

o Resolution – Select resolution order from the dropdown menu 

options, 1/2, 1/4, 1/8 and 1/16 order. 

 

o Max order – Set the maximum order from the dropdown menu 

options, 5,10, 20, 50, 100, 200, 400 and 800 orders. 
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Note: The maximum sampling rate for order tracking is defined by 

[Max Order] × [Max Speed]. If the specified sampling rate exceeds 

your hardware limitation, a warning message will appear. 

 

o RPM Step – If the Armed by RPM is checked, a measurement is 

taken whenever it reaches a specified RPM step. It will begin when 

the Start RPM entered is reached and stop when the Stop RPM 

entered is reached. You can set the Start, Stop and Delta RPM. 

 

Select Event as Start Up, Coast down, or Up and Down.  

If Start Up is selected, dBX Analyzer will take a measurement only 

when the speed is ascending. 

 

o Time Step – Check to measure on specified period. The 

measurement will continue until the time entered or the total number 

of counts is reached. 

 

o Both – Enables the measurement controlled by both time / RPM. 

 

• Average – Set average of your Order Tracking measurement. 

 

 

Figure 212 OT – Average view – example 

o Type of Average – Select Off, Linear, Exponential or Peak Hold. 

 

o Overlap Level – Use the dropdown or the slider to set the overlap 

percentage. 

 

6.13.9 Recorder setup 

 

Select Recorder or Real-time + Recorder mode from the main menu.  

In the main toolbar, select Setup > Recorder Setup. There are two recorder 

measurement modes:  
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• Recorder– The measured raw signal is transferred to the hard drive 

continuously. During data recording, you can monitor basic Spectrum and 

Time Waveform. 

 

• Real time + Recorder – Real-time measurements of FFT or Order Tracking 

run as in the real-time mode. The raw signal is saved to other raw data file(s). 

 

In either of the above modes, use the following menu to set up the data recording. 

There are three sub-menus from the Recorder setup: Frequency, Display and Auto 

Stop. 

 

• Frequency  

 

 

Figure 213  Recorder setup – Frequency view – example 

o Band – Select the Frequency Band. 

o Delay – Input the Delay time value (Sec). 

 

• Display 

 

 

Figure 214  Recorder setup – Display view – example 

Select Time Waveform and/or Auto Spectrum (400 lines) to be displayed during 

recording. 
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• Auto Stop – Set up the raw data recorder to automatically record start / stop 

settings, file size and where to record the data file. If all items are unchecked, 

you must stop the recording manually using the measure toolbar and press 

stop. 

 

 

Figure 215  Recorder setup – Auto Stop view – example 

o Record Time – Enter the length of time to record. 

 

o Start RPM – Enter the starting RPM. It must be greater than 0. 

 

o Stop RPM – Enter the stop RPM.  

 

o Tacho – Select a Tacho channel. 

 

o Maximum file size – Enter the maximum file size you wish to record. 

This is helpful when concerned about large file sizes and storage 

space. 

 

o Save to – Click Browse and select path to save the recorder data 

files. 

 

• Real Time + Raw Data Recorder mode – When measuring in Real time + 

Raw Data Recorder, a Recorder function is added to the Live data panel.  

As the real-time measurement starts, the continuous raw data is also taken 

simultaneously.  
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6.14  Tools menu 
 

Use the Tools menu to perform Sensor Calibration, Rescan Device and Check 

IPC. 

 

  

• Sensor Calibration – Calibrates and adjusts sensors’ sensitivity with a 
calibrator. When a sensor requires calibration before measurement, this 

procedure is used.  

For example, an acoustic calibrator usually generates a 94 dB calibration 

signal at 1 kHz. Therefore, you can use this tool to calibrate its sensitivity very 

quickly. 

 

 

Figure 216  Sensor calibration view – example 

1. Install the microphone to the 94 dB calibrator and connect it to 

Channel 1. 

 

2. Turn the calibrator power on and select Acquire to start the 

measurement. 

 

3. After data acquisition, the microphone sensitivity, in this example,  

is set as 1000 mV/Pa, and the measured dB level is 90.97 dB.  
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4. Input the Reference Amplitude to read 94. It will change the 

microphone sensitivity to 705.577 mV/Pa, which will make the 

measured level 94 dB.  

 

 

• Check ICP – Check the ICP bias voltage when necessary. Select the 

channel for ICP bias checking and then select Start to perform the testing. 

 

 

If the test result shows the status as Open, the ICP sensor is not connected, or the 

cable is faulty.  

Note that the Open ICP bias should be in the range of 25+/-1 V for normal conditions. 

If the tested bias voltage is 0 V and the status Shorted, the cable connected to this 

channel is shorted. 

If a normal ICP sensor and cable is connected to a channel, it will show the normal 

bias of that sensor and show the status as Normal.  

 

• Rescan Device – Check the connection of the data acquisition hardware. 

Select Rescan device to check the connection of the data acquisition 

hardware. After conducting Rescan device, it will show the result as follows. 

A device called U404 will be found and checked. If no device was found, go 

to the Utility application, and perform a reset DAQ to restore the 

connection.  
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6.15   Version information 
 

Tap the information icon  at the top right corner to display the version 

information. 

 

 

Figure 217 About window – example 
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7 dBX Documents 

7.1 Introduction 
 

 

Figure 218 dBX Documents – example 

Double tap the dBX Documents icon on the home screen to open the Documents 

application where Microlog dBX manuals and calibration files are stored. 

 

 

Figure 219 Home screen – dBX Documents icon 
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Open – To open a file, select it from the list and tap Open. 

 

Add file – To add a file, tap Add file and select a file to add. 

 

Delete file – To delete a file, select it from the list and tap Delete file. 

 

Back – Tap to return to the previous view. 
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Appendix A Limited Warranty 
 

SKF – Limited Warranty 

 

If you have experienced an issue with your Microlog Analyzer dBX, to help expedite 

your concern, please contact your nearest SKF Technical Support representative and 

raise a support case.  

 

Download the latest version from  www.skf.com.

https://skftechnicalsupport.zendesk.com/
https://www.skf.com/group/products/condition-monitoring-systems/product-support-training/product-manuals#cid-469921


APPENDIX B 
Data Files 

SKF Microlog Analyzer dBX  

User Manual 

Revision E 

227 (235) 

 

 

Appendix B Data Files 
 

 

File Type 
Name 

extension 
Description 

Project file .npj A project file contains both the setup parameters 

and the measured data. 

Setup File .nst 

A setup file contains the setup parameters only. 

• Analysis Mode 

• Channel Setup 

• Engineering Unit 

• Recorder Setup 

• FFT Setup 

• Order Tracking Setup 

Default File default.nst 

Default Setup File setting. When a new project is 

created, the default setting will be loaded to the new 

project. 

Raw Data .nrd & .nra 

.nrd files contain the header information of a raw 

data file, while the .nra files contain the raw data 

itself.  

 

A complete set of raw data includes one nrd and 

one nra files. 
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Appendix C Unit Table Default Definitions 

 

 

Acceleration Display Unit Int/Diff Scale Factor 

g 

g No 1 

mg No 1000 

m/s2 No 9.8067 

mm/s int*1 9806.7 

in/s int*1 386.091 

cm/s int*1 980.67 

mil int*2 386090 

μm (um) int*2 9.8e6 

    

m/s2 

g No 0.101971 

mg No 101.971 

m/s2 No 1 

mm/s int*1 1000 

in/s int*1 39.37 

cm/s int*1 100 

mil int*2 39370 

μm (um) int*2 1e6 
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Velocity Display Unit Int/Diff Scale Factor 

mm/s 

mm/s No 1 

cm/s No 0.1 

in/s No 0.03937 

m/s2
 diff*1 0.001 

g diff*1 1.0197e-4 

μm (um) int*1 1000 

mil int*1 39.37 

in/s 

mm/s No 25.4 

cm/s No 2.54 

in/s No 1 

m/s2 diff*1 0.0254 

g diff*1 2.59e-3 

μm (um) int*1 2.54e4 

mil int*1 1000 

cm/s 

mm/s No 10 

in/s No 0.3937 

cm/s No 1 

m/s2 diff*1 0.01 

g diff*1 1.019711e-3 

μm (um) int*1 1e4 

mil int*1 393.7 
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Displacement Display Unit Int/Diff Scale Factor 

mil 

mil No 1 

μm (um) No 25.4 

mm/s diff*1 2.54e-2 

in/s diff*1 0.001 

cm/s diff*1 2.54e-3 

g diff*2 2.59e-6 

m/s2 diff*2 2.54e-5 

mg diff*2 2.59e-3  

    

μm 

mil No 3.937e-2 

μm (um) No 1 

mm/s diff*1 1e-3 

in/s diff*1 3.937e-5 

cm/s diff*1 1e-4 

g diff*2 1.0197e-7 

m/s2 diff*2 1e-6 

mg diff*2 1.0197e-4 

Force Display Unit Int/Diff Scale Factor 

lbf 

lbf No 1 

N No 4.4482216 

g No 453.59237 

N 

lbf No 0.22480894 

N No 1 

g No 101.97162 
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Appendix D End User License Agreement 
 

Terms & Conditions    
 

By accessing or using this mobile application of the SKF Group an end user license 

agreement (“Agreement”) has been entered into between you and SKF Sverige AB 
(“SKF”), a company registered under the laws of Sweden, and you agree to be bound 
by the following terms and conditions. If a separate written end user license 

agreement for this mobile application has been agreed by you and an SKF entity, or 

if your employer has an agreement with an SKF entity regarding Microlog Analyzer 

dBX, such agreement will prevail over this Agreement. SKF may at any time update 

or change the Terms and Conditions without giving notice to you.   

 

Limited license 

 

Conditioned upon your compliance with the terms and conditions of this Agreement, 

SKF hereby grants to you a limited, revocable, non-exclusive, personal, non-sub 

licensable, non-transferable, non-assignable license to install and use the executable 

form of the mobile application solely for your personal use on a device (whether 

mobile device or other) owned or controlled by you. All rights not specifically granted 

by SKF under this Agreement are retained by SKF and withheld from you. 

 

Restrictions of use 

 

Except as expressly specified in this Agreement, you may not: (a) copy or modify the 

mobile application; (b) transfer, sublicense, lease, lend, rent or otherwise distribute 

the mobile application to any third party; or (c) use the mobile application in any 

unlawful manner, for any unlawful purpose, or in any manner inconsistent with this 

Agreement. You agree not to disassemble, decompile or otherwise reverse engineer 

any components of the App provided in object code or any other SKF products or 

services, in whole or in part, or permit or authorize a third party to do so, except to 

the extent such activities are expressly permitted by law notwithstanding this 

prohibition. 

 

Warranty Disclaimer and Limitation of Liability 

 

Although due care has been taken to assure the accuracy of the information in this 

mobile application, SKF provides this information "AS IS" and DISCLAIMS ALL 

WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 

PARTICULAR PURPOSE. You acknowledge that your use of this mobile application 

is at your sole risk, that you assume full responsibility for all costs associated with 

use of this mobile application, and that SKF, or any of its group companies, shall not 

be liable for any direct, incidental, consequential, or indirect damages of any kind 

arising out of your access to, or use of the information or software made available in 

this mobile application. 
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Any warranties and representations in this mobile application for SKF products or 

services that you purchase or use will be subject to the agreed upon terms and 

conditions in the specific written contract for such product or service. 

 

Further, for non-SKF sources that are referenced in our mobile application or where a 

hyperlink appears, SKF makes no warranties concerning the accuracy or reliability of 

the information in these sources and assumes no responsibility for material created 

or published by third parties contained therein. In addition, SKF does not warrant that 

this mobile application or these other linked sources are free from viruses or other 

harmful elements. 

 

Copyright 

 

Copyright in this mobile application and copyright of the information and software 

made available in this mobile application rest with SKF or its licensors. The licensed 

open source software and applicable license terms including credits and applicable 

terms for usage by you can be found on www.skf.com All rights are reserved. All 

licensed material will reference the licensor that has granted SKF the right to use the 

material. The information and software made available in this mobile application may 

not be reproduced, duplicated, copied, transferred, distributed, stored, modified, 

downloaded or otherwise exploited for any commercial use without the prior written 

approval of SKF. Under no circumstances may this information or software be 

supplied to third parties.   

 

Trademarks and Patents 

 

All trademarks, brand names, photos and corporate logos displayed in the mobile 

application are the property of SKF or its licensors, and may not be used in any way 

without prior written approval by SKF. All licensed trademarks published in this 

mobile application reference the licensor that has granted SKF the right to use the 

trademark. Access to this mobile application does not grant to the user any license 

under any patents owned by or licensed to SKF. 

    

Changes and termination 

 

SKF reserves the right to make changes or additions to this mobile application at any 

time. This Agreement will terminate automatically upon the earlier of: (a) your failure 

to comply with any term of this Agreement; (b) you deleting the mobile applications(s) 

from your devices; and (c) if you are using the mobile application(s) in connection 

with a paid service, the end of the time period specified at time of purchase. In 

addition, SKF may terminate this Agreement at any time, for any reason or no 

reason. If this Agreement terminates, you must stop using the mobile application(s) 

and delete them from your devices. 

    

Applicable law 

 

The laws of Sweden shall apply to this Agreement. 

http://www.skf.com/
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Export controls 

 

You shall not export or re-export, directly or indirectly, the mobile application, or use 

the mobile application to export or re-export any information, without complying with 

export controls imposed by any applicable country (or any future export control 

legislation) and the regulations promulgated thereunder. 

    

Privacy Notice 

 

SKF will handle any personal data obtained from you in accordance with the [insert 

app name] Privacy Notice. Please read this Privacy Notice carefully before using this 

mobile application.
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Appendix E Federal Communications 

Commission Interface Statement 

 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures: 

-Reorient or relocate the receiving antenna. 

-Increase the separation between the equipment and receiver. 

-Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

-Consult the dealer or an experienced radio/ TV technician for help. 

 
CAUTION:  
 
Any changes or modifications not expressly approved by the grantee of this device 

could void the user's authority to operate the equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and (2) 

this device must accept any interference received, including interference that may 

cause undesired operation. 

 
RF exposure warning   

 
The equipment complies with FCC RF exposure limits set forth for an uncontrolled 

environment. 

The equipment must not be co-located or operating in conjunction with any other 

antenna or transmitter. 
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Appendix F Radio Frequency Identification 

Tag Standards 
 

The following RF tags are supported by the built-in RF identification using near-field 

communication (NFC) located on rear of SKF Microlog Analyzer dBX. 

 

Radio Frequency Identification  

RF Transmit Frequency 13.56MHz 

Supported Transponder 

ISO 15693(R/W) 

ISO 18092(R/W) 

ISO 14443-A(R/W) 

ISO 14443-B (Read UID only) 

 

(Depend on antenna type and antenna 

matching) 

Antenna impedance Loop Antenna, 50 ohms 

Operating Temperature -25°C to + 85°C  

Storage Temperature 5 ~ 97% non-condensing 
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